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PATIENT BOOKING GATEWAY 

 

  Patient Booking Gateway Configuration 
 
The Front Desk Patient Booking Gateway is designed for patients to book and 
manage their own appointments online through an integrated web-based system. 

 
Please note the initial Patient Booking Gateway installation and setup must be 
completed by a Smartsoft staff member.  Please contact Smartsoft for further 
information. 

 
Select Patient Booking Gateway Configuration from the File menu. 
 

 
 
The following window will be displayed. 
 

 
 
Enter the Clinic Name, Clinic Phone number and the Website address (URL) 
which directs patients to the integrated Patient Booking Gateway.  
 
Following installation by Smartsoft, the Patient Booking Gateway address by default 
will use the clinic public IP address e.g. http://116.212.211.142/bookinggateway 
Alternatively, you can use your own domain by speaking with your domain provider 
or web developer about setting up an A Record entry. 
 
Select a Practice Description which best describes how you refer to your practice or 
clinic.  A custom description can be entered manually if required. 
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  Patient Booking Gateway Configuration 
 
Select a Patient Description which best describes how you refer to patients or 
clients.  A custom description can be entered manually if required. 
 

 
 
Select a Practitioner Description which best describes how you refer to your 
practitioners.  A custom description can be entered manually if required. 
 

 
 
A Theme Colour can be selected using the provided drop-down menu.  This colour 
can be used to theme your Patient Booking Gateway to suit your existing branding. 
 

 
 
A custom colour can be chosen by double-clicking on the currently selected colour. 
 

 
 
This allows exact colours to be selected by entering the Red, Green and Blue (RGB) 
values. 
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  Patient Booking Gateway Configuration 
 
A company logo can be added by selecting Use Logo, and clicking Import to load a 
suitable image from your computer.   
 
Please note that logo files must not exceed 55 pixels in height and 200 pixels in length. 
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  Patient Booking Gateway Configuration 
 
Select the Defaults tab from the Patient Booking Gateway Configuration. 
 

 
 
The Default Options allow the user to set whether patients can book appointments, 
classes or both through the Patient Booking Gateway.  Select either Enable 
Appointments & Classes, Only Appointments or Only Classes. 
 
Allow verified patients to make first appointment enables new booking gateway 
users to make appointments online without having had a previous appointment at the 
practice. 
 
Show appointment duration will display the appointment length in minutes to the 
patient booking online. 
 
Allow patients to add notes to their appointments gives patients the option of 
including a note with their booking, which is visible in Front Desk by hovering over 
the patient’s appointment. 
 
Allow Booking Gateway to be embedded in an existing website will format the 
booking gateway appropriately when embedding the site into an existing webpage. 
Secondary to enabling this, you will need to request your web developer to embed 
your gateway using an <iframe> tag. 
 

Select random practitioner when Any Available Practitioner is selected will 
randomly select a practitioner if a patient selects the “Any Available Practitioner” 
option when making an appointment online. 
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  Patient Booking Gateway Configuration 
 
The order practitioners appear to patients can be set to either Alphabetical (by name) 
or Random by selecting the Preferred method of ordering practitioners. 
 

 
 
The Maximum search range limits how far into the future a patient can search for an 
appointment. 
 

 
 
Restrict booking time can be enabled to stop appointments being offered that are 
within set hours from the current time. 
 
Booking order refers to the order in which patients select a business Location and 
Profession on the booking gateway. By default, patients select their location and 
then a profession, which can be reversed if needed. 
 

 
 
Select the desired Cancellation Defaults. 
 
Allow patients to cancel their appointments will give patients access to cancel 
their own appointments outside the minimum cancellation time limit set. 
 
Prompt patient to provide a reason for appointment cancellation will prompt 
patients to enter a reason for cancelling an appointment. 
 
Allow patients to reschedule their appointments will give patients access to 
reschedule their own appointments within the minimum reschedule time limit set. 
 

 
 
In order to prevent unwanted data mining, a Lock Out Default can be set to limit the 
number of appointment options a patient can see before being locked. 
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  Patient Booking Gateway Configuration 
 
Select the Classes tab from the Patient Booking Gateway Configuration. 
 

 
 
When searching the Patient Booking Gateway for available classes, users will be 
asked to enter a date range to search within. 
 
The default date range selected can be adjusted using the Default end time option. 
 

 
 
The Maximum number of group appointments returned per request can also be 
specified. 
 

 
 
Select a Group appointment description which best describes how you refer to 
your group appointments. A custom description can be entered manually if required. 
 

 
 
Select Display number of bookings in a class (e.g. 9/10) to show the total number 
of current bookings within the class.  
 
If Classes have been enabled, select Default to classes section on login to 
automatically direct patients to the classes upon logging into the booking gateway. 
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  Patient Booking Gateway Configuration 
 
Select from the Available Group Appointments / Classes to determine which 
Group Appointments or Classes patients are able to book into online. 
 

 
 
Allow patients to book in all Group Appointments will allow an online booking to 
be made into any Group Appointment with a Class Type set. 
 
Don’t allow patients to book in Group Appointments will not allow online 
bookings to be made into any Group Appointments. 
 
Allow patients to book in the following classes allows the user to select which 
Class Types appear on the booking gateway. 
 
These settings can be overridden for individual patients from the Appointments tab 
of the patient file. 
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  Patient Booking Gateway Configuration 
 
Select the Guest Bookings tab from the Patient Booking Gateway Configuration. 
 

 
 
Select Enable Guest Bookings to allow patients to book on-the-spot appointments 
using the Patient Booking Gateway before their details have been verified by a staff 
member. 
 
Options are available to limit what guests can do online: 
 

• Allow guests to cancel appointments 

• Allow guests to book subsequent appointments or classes 

• Allow guests to reschedule appointments 

• Display fees for guest bookings 
 
 Group Appointments and Classes can also be restricted with the following options: 
 

• Allow guests to book in all Group Appointments 

• Don’t allow guests to book in Group Appointments 

• Allow guests to book in the following classes 
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  Patient Booking Gateway Configuration 
 
Select the Booking Locations tab from the Patient Booking Gateway Configuration. 
 

 
 
Click Add to enter a new booking location. 
 
Click Edit to modify a booking location or Delete to remove a booking location. 
 
The order Booking Locations appear can be adjusted using the blue arrows. 
 

  
 
Enter the Name and Contact Details of the booking location.   
 
Address details can be selected from the registered Clinic address, Practice Group 
headers or entered manually via the Other option. 
 
Opening Hours can be entered manually to be displayed on the Patient Booking 
Gateway website. 
 
Click OK to complete the Booking Location. 
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  Patient Booking Gateway Configuration 
 
Select the Professions tab from the Patient Booking Gateway Configuration. 
 

 
 
Click Add to enter a new profession.   
 
Click Edit to modify a profession or Delete to remove a profession. 
 
The order Professions appear can be adjusted using the blue arrows. 
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  Patient Booking Gateway Configuration 

 
Select Check patient’s last appointment time to restrict online booking for patients 
who have not been treated under the profession in a set amount of time. This can be 
used to ensure patients have gone through a suitable initial assessment or re-
assessment prior to continuing their ongoing treatment.  
 

 
 
Select Require patients to read and confirm the following message if you wish to 
enter a disclaimer or confirmation message each patient must agree to prior to 
booking an appointment.  
 
Enter a Confirmation failed message to appear if the patient does not agree to the 
original confirmation message. This does not apply to bookings made as a Guest. 
 

 
 
Select Display appointment fees on Patient Booking Gateway to display the fee 
to patients booking with this profession. 
 

 
 
The fee displayed is determined within the Appointment Type by selecting a 
corresponding item code for each practitioner.  Only the underlying fee will be 
displayed and not the item code itself. 
 
Double-clicking on the Appointment Type within the Profession will open the 
Appointment Type for editing. 
 
If this option is enabled and one or more of the allowed Appointment Types does not 
have a linked item code (within System Information), a warning will appear. 
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  Patient Booking Gateway Configuration 
 

 
 
To restrict appointment bookings to specific Appointment Types, see the 
Appointment Type Options section within each Profession. 
 
Use patient’s default Appointment Type, then the clinic default will use the 
patient’s default appointment type where possible, or otherwise use the clinic’s 
default appointment type. 
 
Allow the patient to select from these Appointment Types allows the patient to 
select from a specified list of appointment types. 
 

 
 
Click OK to complete the Profession. 
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  Patient Booking Gateway Configuration 
 
Select the Practitioners tab from the Patient Booking Gateway Configuration. 
 

 
 
Select a practitioner to setup for the Patient Booking Gateway and click Edit. 
 

 
 
To enable the practitioner for the Patient Booking Gateway, select Available for 
Patient Booking Gateway. 
 
Enable Only available for classes to only allow class bookings for this practitioner. 
 
Enable Allow guest bookings to allow un-registered patients to make appointments 
with this practitioner online. This can be configured to allow New and existing 
patients or Existing patients only. 
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  Patient Booking Gateway Configuration 

 
Select a Booking Location for the practitioner.   
 

 
 
This will determine at which location patients can make an appointment with this 
practitioner. 
 
Click Add to select one or more Professions for the practitioner. 
 

 
 
The This practitioner’s patients can make appointments with option can be used 
to specify which practitioners a patient can make appointments with when this 
practitioner is selected as their Default Practitioner. 
 
Any practitioner will allow the patient to make appointments with any practitioner 
available. 
 
This practitioner only will allow the patient to make appointments only with their set 
Default Practitioner. 
 

 
 
Specific practitioners / practice groups will allow the patient to make 
appointments with specifically selected practitioners and practice groups. 
 
Click Edit to select practitioners and practice groups. 
 
Click OK to confirm the selection. 
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  Patient Booking Gateway Configuration 
 
The Select this practitioner by default option allows the user to specify which 
practitioner will be the default for patients with this practitioner is selected as their 
Default Practitioner. 
 
Last practitioner seen will set the last practitioner seen by the patient as the default.  
 
Random practitioner will randomise the practitioner selected by default. 
 
Specific practitioner will set a specific practitioner as the default.  
 

 
 
Click OK to complete the practitioner setup.  
 

 
 
Practitioners set as Available for Patient Booking Gateway will appear with a tick 
next to their name, and are now setup for the Patient Booking Gateway. 
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  Patient Booking Gateway Configuration 
 
Select the Start Times tab from the Patient Booking Gateway Configuration. 
 

 
 
If required, this allows users to restrict appointments to available times starting at 
a specific time. 
 
Click Edit to select the start times you wish to be available for online booking. 
 

  
 
Please note this applies to all professions and practitioners using the Patient Booking 
Gateway.  
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  Patient Booking Gateway Configuration 
 
Select the Email tab from the Patient Booking Gateway Configuration. 
 
Enter your Mail Server (SMTP) Settings.  
 
If you have already entered your SMTP settings within the Email tab of System 
Information, these details can be automatically copied using the Copy Front Desk 
SMTP settings button. 
 
If you are unsure of your SMTP email settings please contact your system 
administrator or ISP (Internet Service Provider) for further assistance. 
 

 
 
Enable Receive messages (e.g. patient contact requests) via email and enter an 
Email recipient to receive email notifications from patients requesting to be 
contacted. 
 
A Blind Carbon Copy or BCC can be sent to nominated email addresses for all 
outbound emails by entering an email address into the BCC all outbound emails to 
field.  
 
Multiple email addresses can be separated with a semicolon as below: 
info@smartsoft.com.au; bookinggateway@smartsoft.com.au; frontdesk@smartsoft.com.au 

 

 
 
Link Expiry Times can be set to expire password reset links and login request links 
after a set period of time.  
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  Patient Booking Gateway Configuration 
 
Select the Email Templates tab from the Patient Booking Gateway Configuration. 
 
When using the Patient Booking Gateway an email notification may be sent to either the 
patient or the practice when certain events are triggered.  These email templates can be 
modified to suit the practice. 

 

 
 
Select an Email Template Name and click Edit to modify an existing email template. 
 
The Subject and Body information can be adjusted by typing over the existing text.   
 
Please note the Letter Tags within the body of the email will populate with patient 
information vital to the email’s purpose. 
 

 
 
Click OK to complete the Email Template. 
 
 
 
 

Default will reset 
the email template 
to the default. 

The event which 
triggers the email  
is detailed in the 
description. 

The Preview option will 
populate the Letter 
Tags with patient data. 

The email body 
contains Letter Tags 
for merging in the 
patient details. 
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  Patient Booking Gateway Configuration 
 
Select the Advanced tab from the Patient Booking Gateway Configuration. 
 

 
 
Click Include link to practice privacy policy to add a link to your privacy policy on 
the booking gateway website.  
 
Google Analytics activity tracking can be enabled for the Patient Booking Gateway 
by pasting your Analytics JavaScript snippet (provided by Google) into this window. 
 
Google Tag Manager can also be used to further integrate the Booking Gateway 
with Google Analytics. 



PAGE  25                                                                             FRONT DESK 2021 - PRACTICE MANAGEMENT SYSTEM 

PATIENT BOOKING GATEWAY 

 

  Patient Booking Gateway Configuration 
 
Select the Bulk Email option from the Patient Booking Gateway Configuration. 
 
The Bulk Email option allows users to send bulk emails to patients within the Front 
Desk database.  This is used to send a personalised invitation to patients to register 
and begin using the Patient Booking Gateway. 
 

 
 
The following window will appear. 
 

 
 
By default Include patients who have already received a login request is not enabled. 
 

 
 
The Filter options can be used to select only patients who meet the selected criteria. 
 
For example enabling both Appoint between and the Appointment with filter will 
select patients who have had an appointment during a set date range with a certain 
practitioner or practice group. 

Bulk Email 
option. 
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  Patient Booking Gateway Configuration 
 
Click Email to send an email to those patients with an email address. 
 

 
 
Individual patients can be selected or deselected from the Select column. 
 
Click All to select all patients within the list, or click None to deselect all patients. 
 
The Message Template can be adjusted from within the Email Templates tab of the 
Patient Booking Gateway Configuration. 
 
Click Send to send the selected emails.   
 
Click Yes to confirm the selection. 
 

 
 
The selected patients will now receive an email invitation to begin using the Patient 
Booking Gateway.  
 
 
 
 
 
 

Subject 

Send button. 

Deselect all patients. 

Select all patients. 

Select or deselect 
individual patients. 

Template selection 
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  Patient Booking Gateway Logins 
 
To view the current Patient Booking Gateway users, select Patient Booking 
Gateway Logins from the System menu. 
 

 
 
The following window will appear. 
 

 
 
By default the listing will show the last four weeks of unverified login details.  This can 
be adjusted with the Date Range and Status options. 
 
Not verified will list patient logins which are awaiting verification or partially verified. 
 
Verified will list patient logins which have been successfully verified and are ready to 
use within the Patient Booking Gateway. 
 
Email to be confirmed will show patient logins which have been registered via the 
Patient Booking Gateway website, but not been confirmed via email. 
 
Deleted will list patient logins which have been deleted from the system. 

All will list patient login details of any status. 

 
 
 

Date Range 

Status 
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  Patient Booking Gateway Logins 
 

 
 

When a patient has registered via the website, the option to Process, Email, or 
Delete the login request becomes available. 
 
Select Process to link the registration request to a patient file.  This can be an 
existing patient file, or a new patient file. The following Process Login Requests 
window will appear. 
 

 

Process 
 Email 
 Delete 
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Patient Booking Gateway Logins 
 
The Registration Request Details will be listed at the top of the window.  This can 
be used to compare the requesting patient details against an existing patient file. 
 

 
 
If the patient has indicated they are an existing patient, the Front Desk system will 
automatically attempt to find patient files with matching information. 
 

 
 
If the returned results do not match sufficiently, users can search the database for a 
better matching patient file by selecting Search for patient. 
 

 
 
 
 



PAGE  30                                                                             FRONT DESK 2021 - PRACTICE MANAGEMENT SYSTEM 

PATIENT BOOKING GATEWAY 
 

  Patient Booking Gateway Logins 
 
Once a patient file suitable to link with the registration request has been found and 
selected, click Next to begin the Merge Patient Details process. 
 

 
 
The Merge Patient Details window allows users to update the existing patient file 
with the details registered for the Patient Booking Gateway by the patient. 
 
Select Update All to update all available patient details. 
 
Otherwise, selecting the arrow between each row will replace that specific line of 
information.  
 

 
 

 
 

 
 
Click Finish to complete the registration process. 
 
Click Back to return to the Registration Request Details, or Cancel to close the 
window without processing. 

Merge Row 
 

Updated information 
in existing patient file. 
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  Patient Booking Gateway Logins 
 
If the registration request cannot be linked to an existing patient file, click New to 
create a new patient file. 
 
The registration request details will be copied to the new patient file automatically. 
 

 
 
Click OK to complete the patient file creation.   
 

 
 
Upon closing and saving the patient file, the following window will appear. 
 

 
 
If the patient has registered indicating they are a new patient, the following window 
will appear. 
 

 
 
By selecting the Search for patient option users can search for an existing patient 
file to link the registration to if required. 
 
Otherwise click New to create a new patient file using the registration request details. 
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  Patient Booking Gateway Logins 
 
Click Email to resend the Patient Booking Gateway activation email to the patient. 
 

 
 
The following window will appear. 
 

 
 
Click Yes to resend the login request, or click No to cancel. 
 
Once a patient has confirmed their registration request via email, the Status 
becomes Awaiting verification - patient registered via website.   
 
The patient can then be processed and linked to a patient file. 
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  Patient Booking Gateway Logins 
 
If a new patient file is created, or the linked existing patient file has not had an 
appointment with a practitioner of the same Profession, the first appointment will 
need to be made manually by the clinic. 
 
When this occurs the Status becomes Partially verified - first appointment needs 
to be made. 
 

 
 
If the linked patient file has previously had an appointment with a practitioner of the 
same Profession, or an appointment has since been made, the Status will become  
Verified - Patient can use the Booking Gateway. 
 

 
 
The Patient Booking Gateway login registration is now complete.  
 
Completed registrations can be viewed under the Verified status option.  
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  Patient Booking Gateway Logins 
 
Click Delete to remove an incomplete login request.  
 
Please note that only login requests listed under the Email to be confirmed status can 
be deleted.  
 

 
 
A confirmation window will appear. 
 
Click Yes to delete the login request, or click No to cancel. 
 

 
 
Please note that once a login request has been deleted it cannot be undeleted and 
must be resubmitted manually. 
 
If required, access to the Booking Gateway can be revoked for patients who have 
already been verified from the Appointments tab of the patient file.   
 
To remove access to the Booking Gateway deselect Patient has access to the 
Patient Booking Gateway as below. 
 

 

Deselect to  
remove access. 
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Web Appointment Book (Standard) 
 

Front Desk includes a read only Web Appointment Book, which allows users to view 
their appointments using a standard web browser.  This functionality is ideal for 
allowing practitioners and staff to view the appointment book while off-site.  
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Web Appointment Book 
 

A prerequisite for installing the Front Desk Web Appointment Book is one of the 
following operating systems: 
 

▪ Windows Server 2008 
▪ Windows Server 2008 R2 
▪ Windows Server 2012 
▪ Windows Server 2012 R2 
▪ Windows Vista Home Premium (or above) 
▪ Windows 7 Home Premium (or above) 
▪ Windows 8 / 8.1 

▪ Windows 10 

 
There are two main steps to install the Web Appointment Book.  
 

1) Installing the Front Desk Web Appointment Book  
2) Configuring Port Forwarding in your Modem/Router 

 
 
Step 1 – Install the Front Desk Web Appointment Book Utility 

 
Insert the Front Desk 2021 CD into your CD-ROM.   
 
The dialog below should automatically appear on your screen. 
 

 
 
Please note: If the dialog above does not appear automatically you may need to 
open the Front Desk CD manually.  From the Start Menu click Computer and then 
double click on the CD-ROM drive labelled Smartsoft. 
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Web Appointment Book (Installation) 
 

From the left hand side menu select Web Appointment Book and then click Install 
Web Appointment Book. 
 
The following dialog will appear on your screen. Click Next to continue. 
 

 
 
Please read and accept the End-User License Agreement and then Accept and 
Install. 
 

 

 



PAGE  38                                                                             FRONT DESK 2021 - PRACTICE MANAGEMENT SYSTEM 

WEB APPOINTMENT BOOK 

 
Web Appointment Book (Installation) 
 

 
Follow the prompts to complete the installation.  This install should take 
approximately 5 minutes. 
 
We recommend that you install the Web Appointment book in the default destination 
folder. 
 
Once you have successfully completed the installation you will find the Front Desk 
Web Setup icon under the Smartsoft program listing. 
 

 
 
Click Front Desk Web Setup and select the location of the Front Desk database. 
 
Select Local Database if the Front Desk database is on the same machine, or 
Network Database to select another computer on your network by either entering 
the machine name or network IP address of the machine. 
 

 
 
Once you have selected the database location click Test Database to check your 
database connection. To test the website click Test Website.  
 
Click OK to save your configuration settings.  
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Web Appointment Book (Installation) 
 

Step 2 – Port Forwarding 
 
To access the Web Appointment Book from outside of the practice, port forwarding 
will need to be setup in your modem/router. Please refer to your technical support 
specialist for assistance with this.  
 
Accessing the Web Appointment Book on a local PC  
To view the Front Desk Web Appointment Book on a PC, open a web browser and 
navigate to http://localhost/FrontDesk. Alternatively, you can replace ‘localhost’ with 
the local IP address or the computer name. 
 

 
 
Accessing the Web Appointment Book on a local Mobile device  
To view the Front Desk Web Appointment Book on a mobile, such as an iPhone or 
Android device, open a web browser and navigate to 
http://computername/FrontDesk/Mobile. Once again ‘computername’ can be replaced 
with the local IP address if needed. 
 
Accessing the Web Appointment Book from outside the practice 
Once port forwarding has been configured, the Web Appointment Book can be 
accessed from outside the practice using the same links as above, however 
‘localhost’ or ‘computername’ must be replaced by the Public IP address of the 
practice. 
 
Please note the machine hosting your Web Appointment Book must be powered on 
and connected to the network or internet for the page to be accessible. 
 

Congratulations, you have successfully installed the  
Front Desk Web Appointment Book. 

 

http://localhost/FrontDesk
http://computername/FrontDesk/Mobile
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Web Appointment Book – Insights Dashboard 
 

Front Desk Insights is a reporting dashboard that allows users to create 
customisable widgets and present their practice management data as graphs, tables 
and KPI metrics. This provides live business intelligence, offering clear and flexible 
feedback on day-to-day business operations. 
 

 
 
Accessing Front Desk Insights 
 
To access Front Desk Insights, visit the login screen of your Web Appointment Book 
and select the Insights button. 
 
The Web Appointment Book login screen can be accessed in a web browser by 
navigating to http://localhost/FrontDesk/Dashboard. Alternatively, you can replace 
‘localhost’ with the local IP address or the computer name. 
 

 

 

http://localhost/FrontDesk/Dashboard
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Web Appointment Book – Insights Dashboard 
 

After installation, Front Desk Insights can only be accessed by the Admin user. We 
recommend using the Admin account to explore, setup and familiarise yourself with 
Front Desk Insights.  
 
For other users, access to Front Desk Insights is provided on a per dashboard basis 
under the Insights tab in Front Desk from System > Security > Access. A user can 
either have full or read only access to the dashboards made available to them. 
 

 
 
User Access 
 
It is important to note that a Front Desk Insights user will only have access to practice 
groups and locations as specified within the Practice Groups/Locations tab. 
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Web Appointment Book – Insights Dashboard 
 

 
Creating and Editing Dashboards 
 
Front Desk Insights includes a single default dashboard. Additional dashboards can 
be created for different purposes, such a location or practitioner specific dashboard, 
or for different business roles i.e. practice manager, practitioner etc.  
 
To add a new dashboard, select the dropdown menu at the top of the screen and 
select New Dashboard. To edit existing dashboards, select the pencil icon. 
 
 

 
 
To add your clinic logo to all dashboards, select ‘click to add your logo’ in the top left. 
You can drag and drop your clinic logo onto this screen or click to browse. 
 

 
 
When adding or editing dashboard, you can customise the following properties. 
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Web Appointment Book – Insights Dashboard 
 

Adding Widgets 
 
Adding widgets to your dashboards is as simple as clicking the + icon in the top right 
of the screen. Here, you will also find options to refresh the selected dashboard, 
switch to full screen view and to logout. 
 

 
 
Front Desk Insights currently includes 6 types of widgets that can be customised in 
many ways. 
 

 
 
After selecting the widget type you will be able to start customising your widget name 
and selecting what type of widget to add. Widgets have three key areas that can be 
customised:  
• Date – Select a primary and comparison date range (optional)  
• Filters – Select what data should be included in the widget  
• Display – Selected how the data should be presented in the widget 
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Web Appointment Book – Insights Dashboard 
 

 
 
Select Add to drop the widget into your dashboard. 
 
When mousing over a widget, you can choose to refresh the data, edit settings, 
duplicate and delete. 
 

 
 
The quick select options at the top of the dashboard can be used at any time to 
temporarily override the date range and practitioner/group of all widgets on a 
dashboard. 
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How to Enable iCalendar in Front Desk 
 

iCalendar integration allows a practitioner’s Front Desk appointment book to be 
exported to iCalendar format. This format can used with iCalendar compatible 
applications such as Microsoft Outlook, Apple Calendar, or Mozilla Thunderbird. 
 
On the Appointment Book tab in System Information, enter the URL for your Front 
Desk Web Appointment Book (e.g.smartsoftclinic.appointment.mobi/frontdesk). Your 
Web Appointment Book address generally includes the directory /frontdesk. 
 

 
 
On the Appointment Book tab of the Practitioner file, check Enable iCalendar for 
this practitioner. This will generate a URL, which will be used by your iCalendar 
compatible application.  
 
Click Email to send it to the practitioner, or Copy to Clipboard if you will be pasting 
it into another application on the same computer. 
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How to Enable iCalendar in Front Desk 
 

 
 
This section of Front Desk also allows users to choose how many appointments they 
would like to be sent to iCalendar. By default this is set to 1 week in the past, and 2 
weeks in the future, both can be set up to 12 weeks. The current week’s 
appointments are always included. 
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How to Setup iOS (iPhone / iPad) Integration 
 

The following guide details how to sync the Front Desk Appointment book with an 
iOS device through the use of an iCalendar link. 
 
Go to Settings, then Passwords & Accounts.  
 
Select Add Account... 
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How to Setup iOS (iPhone / iPad) Integration 
 

Select Other. 
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How to Setup iOS (iPhone / iPad) Integration 
 

Select Add Subscribed Calendar 
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How to Setup iOS (iPhone / iPad) Integration 
 

Copy and paste your iCalendar URL into the Server field, and press Next. 
 

 
 
Press Next/Save. 
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How to Setup iOS (iPhone / iPad) Integration 
 

 

 
 
Your Front Desk Appointment Book should now be synced with your iOS Calendar. 
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How to Setup iOS (iPhone / iPad) Integration 
 

You can now open the Calendar App on your iOS device to view the synchronised 
appointment details. 
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How to Setup Microsoft Outlook 2010 Integration 
 

Select the File tab.  
 
From the Account Settings drop-down, select Account Settings. 
 

 
 
Select the Internet Calendars tab, and click New. 
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How to Setup Microsoft Outlook 2010 Integration 
 

Paste your iCalendar URL into the New Internet Calendar Subscription dialog, and 
click Add. 
 

 
 
The following window will be displayed. Click OK. 
 

 
 
You will now see your calendar listed, as below: 
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How to Setup Microsoft Outlook 2010 Integration 
 

 
 
To display your calendar, go to Calendar in Outlook. Under Other Calendars on the 
left-hand side you should see your Front Desk iCalendar. Check this option to display 
it. You may need to restart Outlook for these changes to take effect. 
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How to Setup Microsoft Outlook 2010 Integration 
 

Your Front Desk Appointment Book should now be synced with Outlook. 
 

 

 



PAGE  57                                                                             FRONT DESK 2021 - PRACTICE MANAGEMENT SYSTEM 

ICALENDAR 

 
How to Setup Microsoft Outlook 2010 Integration 
 

The following is an example of some Appointments in Front Desk 
 

 
 
And below is the corresponding information viewed in a synconronised Microsoft 
Outlook Calendar 
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How to Setup Microsoft Outlook 2010 Integration 
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How to Setup Mac OS Calendar Integration 
 

Open the Calendar. Select New Calendar Subscription... from the File menu. 
 

 
 
Copy and paste your iCalendar URL into the Calendar URL window. Click 
Subscribe. 
 

 
 
Click OK. 
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How to Setup Mac OS Calendar Integration 
 

You should see your Front Desk Subscribed Calendar listed on the left-hand side. 
Your Front Desk Appointment Book should now be synced with your Apple Calendar. 
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Medicare / DVA Online Claiming (System Information)  
 
Select the Medicare Online tab from the System Information dialog. 
 

 
 
The settings available from this window are vital to the Medicare/DVA Online 
Claiming integration within the Front Desk - Practice Management System. 
 
Please do not adjust these settings without Smartsoft assistance. 
 
If required, the following settings can safely be adjusted without negative effects: 
 

 
 
Select This computer accesses the Internet via a proxy server and enter the 
appropriate server details if required. 
 
Select Check for pending claims on startup to be prompted when pending PCI 
claims have been stored and are available to be sent. 
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PCI Claim 
 
Front Desk allows users to process 2 different types of Patient Claims; these are 
referred to as Patient Claims: Interactive (PCI) and Patient Claims: Store & 
Forward (PCS). 
 
Patient Claims: Interactive (PCI) allows real-time processing of a single claim, and 
is available during Medicare Australia operating hours. PCI allows claims to be 
transmitted and assessed at the time of billing, and will return an outcome 
immediately. 
 
Patient Claims: Store & Forward (PCS) involves preparing and authorising the 
claim, storing the claim, and then forwarding it to Medicare at a more convenient 
time. PCS is the required method of transmitting claims outside Medicare Australia 
operating hours. 
 
Note: Medicare Australia operating hours are: 
7am to 9pm (AEST), Monday to Friday (except National Public Holidays) 
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PCI Claim 
 
PCI claims are generally sent to Medicare at the time of billing or receipting the 
patient, but a claim can be submitted to Medicare up to 2 years after the treatment 
date. 
 
Submitting A Patient Claim From The Receipt Screen 
 

 
 
If the patient would like to claim their Medicare rebate on the spot, tick the Medicare 
PCI option on the Receipt screen. 
 
After payment has been taken, the Medicare Claiming Wizard will be displayed. 
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PCI Claim 
 
The first page displays patient information and a list of the items to be claimed 

through Medicare. Clicking on the  button allows additional information to be 
entered about the claim. 
 

 
 
Select any relevant options and click OK to return to the Wizard. 
 
Click Next to continue to the next page. 
 

 
 
The Online Claiming - Referral Details page is displayed. If referral details were 
entered for the patient these will be displayed here. If there are no referral details 
then the No referral details available option will be selected, and a reason must be 
selected from the list. 
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PCI Claim 
 

 
 
If Hospital is selected, the following page will be displayed to enter the name of the 
hospital where the treatment took place.  
 

 
 
Click Next to continue. 
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PCI Claim 
 

 
 
The next page allows Claimant Details to be entered. If the patient will not be the 
one claiming the rebate from Medicare, then select Use alternate claimant details. 
This will automatically display claimant details if they have been entered on the 
patient’s file, or it will allow users to search for a claimant. This would typically be 
used in the case where a child is the patient, and the rebate will be sent to a parent. 
 
This page also allows the patient to select whether they would prefer the benefit to be 
paid Using details registered with Medicare or if they would like an EFT payment 
directly into their bank account. 
 
Click Next to continue. 

 

 
 
The Bank Account and Postal Details 
page is displayed. 
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PCI Claim 
 
This page allows bank account details to be entered (if EFT was selected on the 
previous page), and allows an alternate postal address to be specified if the cheque 
(or statement, for EFT payments) is to go to an address other than the one in 
Medicare Australia’s records.  
 
Click Next to continue. 

 

 
 
The Submit Claim page is displayed. 
 
The patient must then give their consent to have the claim submitted electronically to 
Medicare Australia. 
 
Check The patient has been asked if they would like the claim to be submitted 
on their behalf if they agree. 
 
If submitting a PCS claim, check the Claim using Store & Forward option. 
 
Click Submit. The claim will then be sent to Medicare Australia. 
 
If the claim is accepted, a Statement of Claim and Benefit Payment will be printed 
(if the Print option is selected). 
 
If the claim is rejected, the following screen will be displayed. 
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PCI Claim 
 

 
 
An Unacceptable error level means that the claim cannot be accepted with the 
current details. It must be cancelled and started again. 

 

 
 
An Acceptable error level means that the claim cannot be processed automatically 
and it needs to be referred to Medicare and processed manually. To do this, click 
Accept. 
 
The following message will be displayed 
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PCI Claim 
 
A Lodgement Advice will then be printed. 
 
If the Claim using Store & Forward option is checked, a Lodgement Advice will be 
printed (If selected), and the following page will be displayed. 

 

 
 
Click Finish to close the Wizard. 
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PCI Claim 
 
It is also possible to claim directly from the Billing screen. 
 

 
 
Check the Medicare PCI option and then click OK. 
 
If the transaction is paid in full, the claiming process is identical to claiming from the 
Receipt screen. 
 

 
 
If no payment or a part-payment has been made, the Medicare Online Claiming 
Wizard will appear differently. 
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PCI Claim 
 

 
 
The first page displays the text “Items not paid in full. Claim will be made on the 
provider’s behalf.” 
 
This means that no benefit will be paid to the patient. The benefit will instead be paid 
to the practitioner. 
 
Click Next to continue. 
 

 
 
The Online Claiming - Referral Details page is displayed. 
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PCI Claim 
 
Click Next to continue. 
 

 
 
The Claimant Details page is displayed.  If the patient has paid on the day, users 
can select whether to pay the benefit Using details registered with Medicare or By 
EFT (bank account details will be required). 
 
When the benefit is paid to the practitioner, the only option is to have a cheque sent 
out. This cheque will be posted to the patient / claimant who will then have to present 
it to the practitioner. 
 
Click Next to continue. 

 

 
 
The Postal Details page is displayed. 
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PCI Claim 
 
Enter any relevant details and click Next to continue. 
 

 
 
The Submit Claim page is displayed. Once the patient has given consent for the 
claim to be submitted, click Submit to send the claim to Medicare Australia. 
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Forward PCS Claim 
 
To forward a stored PCS Claim, go to the System menu and select Medicare 
Claims. 
 

 
 
The following screen is displayed. 
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Forward PCS Claim 
 
PCS claims that have not yet been forwarded will have the state Stored and will be 
displayed when the Claim State is set to Incomplete. 
 
Find the PCS claim that you wish to forward to Medicare Australia, highlight it and 
click on the Send button. 
 
You will be asked if you want to forward the stored claim. 
 

 
 
Click Yes. A progress bar will be displayed while the claim is being submitted. 
 

 
 
Once the claim has been submitted, the State will change to Forwarded and it will no 
longer be displayed on the screen. To view all Forwarded claims, select Completed 
from the Claim State drop-down list at the top of the screen. 
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Medicare Bulk Bill 
 
Front Desk also provides the ability to send Bulk Bill claims to Medicare Australia 
over the Internet. 
 

 
 
To submit a Bulk Bill claim from the Billing screen, check the Bulk Bill option at the 
bottom of the screen. 
 
Note: this option is only available when no payment has been made.  
 
Click OK. The Medicare Online Claiming Wizard will be displayed. 
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Medicare Bulk Bill 
 

 
 
Click Next to continue. 
 

 
 
The Bulk Bill Claim - Referral Details page is displayed. 
 
Click Next to continue. 
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Medicare Bulk Bill 
 

 
 
The Submit Bulk Bill Claim page is displayed. 
 
The patient must agree that they authorise the assignment of their right of benefit to 
the practice. Check this option and click Submit. 
 
A Bulk Bill Assignment Advice (DB4) will be printed (if the Print option is 
selected). 
 
The Bulk Bill Summary page is displayed. 
 

 
 
This will contain details of any errors in the claim. Click Finish to close the Wizard. 
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DVA Allied Health Claim 
 
Front Desk also provides the ability to submit DVA Allied Health Claims over the 
Internet. 
 

 
 
To submit a DVA claim from the Billing screen, check the DVA Claim option at the 
bottom of the screen. 
 
Note: this option is only available when no payment has been made.  
 
Click OK. The Medicare Online Claiming Wizard will be displayed. 
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DVA Allied Health Claim 
 
The first page displays patient information and a list of the items to be claimed 

through Medicare. Clicking on the  button allows additional information to be 
entered about the claim. 
 
Depending on the type of practitioner, different options are displayed on this screen: 
 
Allied Health (including Chiropractic, Occupational Therapy, Osteopathic, 
Physiotherapy, Podiatry) 
 

 
 
Dental 
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DVA Allied Health Claim 
 
Psychology and Speech Pathology 
 

 
 
For Speech Pathology claims, a Duration must also be entered for each item 
claimed. 
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DVA Allied Health Claim 
 
Click Next to continue. 
 

 
 
The DVA Claim Details - Referral details page is displayed. 
 
Click Next to continue. 
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DVA Allied Health Claim 
 

 
 
The practitioner must certify that the services within the claim have been provided. 
Check this option then click Submit. 
 
If the Print option is selected, DVA Claim for Treatment Services (D1217) will be 
printed, and 2 copies of a DVA Health Practitioner Service Voucher (D1216S) will 
also be printed. 
 
The DVA Summary page is displayed. 
 

 
 
Click Finish to close the Wizard. 
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Submitting Claims from Patient Transaction tab 
 
It is also possible to submit Patient Claims, Bulk Bill Claims and DVA Allied 
Health Claims from the Transactions tab on the Patient file. 
 

 
 
Find the transaction for which you want to submit a claim, right click and go to 
Medicare Online. You can then select to submit a Patient Claim, a Bulk Bill Claim 
or a DVA Claim. 
 
Note: Bulk Bill and DVA claims cannot be submitted for claims where a 
payment has already been made. Patient Claims, Bulk Bill, and DVA Claims 
cannot be submitted more than once. 
 
To determine whether an item has already been claimed through Medicare Online 

Claiming, click on the  symbol to the left of a billed item. 
 
If a claim has already been submitted, the type of claim (PCI, PCS, BB or DVA), the 
date and time of submission, and the Claim State will be displayed. 
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Same Day Delete 
 
Front Desk includes functionality to delete PCI claims which have already been 
submitted to Medicare Australia, provided that they are deleted on the same day as 
they were submitted. This is called Same Day Delete (SDD). 
 

 
 
Go to the System menu and select Medicare Claims. 
 

 
 
Find the PCI claim to be deleted, and click Delete.  You will be asked to enter a 
reason for the deletion. 
 

 
 
A progress bar will be displayed while the deletion is being processed. 

 
Once the claim has been deleted you will be returned to the Medicare / DVA Claims 
screen. 
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Bulk Bill / DVA Reports 
 
Bulk Bill and DVA reports are available within 3 business days after submitting a 
claim. 
 
There are two kinds of reports available: 

Processing Report - provides information relating to the claim and services within 
that claim. 

Payment Report - details the payment to be deposited including the amount and 
bank account details along with the list of claims covered by the payment. 

Both reports can be requested (and re-requested) as required and are available to 
download from Medicare / DVA for 6 months after they were generated. Once these 
reports have been viewed once in Front Desk they will be permanently stored and 
will not need to be re-requested from Medicare / DVA. 

To retrieve a Processing or Payment Report, go to the System menu and select 

Medicare / DVA Claims. 
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Bulk Bill / DVA Reports 
 
Open the Medicare / DVA Claims window from the System drop-down menu and 
select Process. 

 

The following dialog will appear, click Yes to continue. 
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Bulk Bill / DVA Reports 

The following screen will appear listing patient transactions and whether a report is 
available. 

 

Once completed, you can allocate payment for each claim that has been paid. 

 

The following screen summarises how many reports were requested, how many 
were successfully retrieved and how many payments were allocated in Front Desk. 
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Bulk Bill / DVA Reports 

To view reports for a single transaction, highlight the transaction and click Reports. 

 

If a processing and/or payment report is available the following screen will appear.  
To preview the report click the Preview button.  The report can be printed by clicking 
the Print button. 

 

If no reports are available the following message will appear. 
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Bulk Bill / DVA Reports 
 
View the payment report by selecting the Payment Report tab.  The payment report 
can be previewed on-screen by clicking the Preview button or printed by clicking the 
Print button. 
 

 
 

Medicare / DVA Payments Report 

There are two reports in Front Desk which allow users to see all Medicare / DVA 
payments, and which are intended to simplify bank statement reconciliation. The first 
of these can be found by selecting Banking Sheets / Shift Reports from the 
Reports menu. 
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MEDICARE / DVA ONLINE CLAIMING 
 

Medicare/DVA Payments Report 
 
If you have enabled Medicare / DVA Online Claiming or Medicare / DVA Reports 
Only on the Advanced tab in System Information, then under Report Types there 
will be an extra option called Medicare / DVA Payments. 
 

 
 
This report is based on the date the Medicare / DVA payment was allocated in Front 
Desk. It will list all DVA and Bulk Bill payments made during this period, along with 
information relating to the bank deposit (Account Name, Number, BSB, Payment Run 
Number and Deposit Amount). The total of this report should be equal to the 
Medicare / DVA value in the Payments Received section of the Summary Report. 
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Medicare/DVA Report 

The second Medicare / DVA Payments report can be found by selecting Medicare / 
DVA Report from the Reports menu. 

 

  

This report is displayed in the same format as the previous report. Whereas the other 
report was based on the date of allocation, this report is based on deposit date (i.e. 
the date when Medicare / DVA made the bank deposit). 
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Medicare/DVA Payments 
 
The Medicare / DVA Payments report can be accessed from the System drop-down 
menu.  This report allows users to view all the Medicare / DVA Online payment runs. 

 

 
 
The following window will be displayed. 
 

 

Edit allows users to 
change the date of 
payment 

Click the + symbol to 
see all payments paid 
by the selected 
payment run 
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Setting up HICAPS / EFTPOS (System Information) 
 

Before we begin the setup of HICAPS/EFTPOS Integration, please ensure the 
following: 

▪ You have a list of HICAPS item codes for your practice 
▪ The HICAPS terminal is connected via phone line or ethernet cable 

(depending on terminal model). 
▪ The HICAPS terminal is connected to a serial or USB (via an adaptor) port on 

your computer  
▪ The HICAPS terminal is turned on 
▪ You have installed the HICAPS Connect software 

 
To enable HICAPS integration, select HICAPS on the Health Fund / EFTPOS / 
Medicare tab on the Advanced tab in System Information. 
 
Check Health Fund Claiming (and EFTPOS Integration if you wish to process 
EFTPOS payments through the HICAPS machine). 
 
If you will be processing Medicare Easyclaim claims through the HICAPS terminal, 
check the Medicare Easyclaim Integration option. This option cannot be used on 
the same computer as Medicare / DVA Online Claiming. Contact Smartsoft for help 
deciding which option best suits your practice. 
 
For computers not directly connected to a HICAPS terminal but which are still 
required to generate HICAPS reports, check the HICAPS Reports Only option.  
 

 
 

Front Desk 2021 - Note 
If you select any of the advanced options, you will be asked to restart Front Desk 
2021 for the changes to take effect. 
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Setting up HICAPS / EFTPOS (System Information) 
 

Once Front Desk has restarted go to System Information and select the 
HICAPS/EFTPOS tab.  
 

 
 
Front Desk needs to search for the HICAPS terminal, to do this click Search. If the 
search fails, check that your HICAPS terminal is correctly connected to a serial or 
USB port on a computer in the network, and that the HICAPS Connect software can 
detect the terminal. 
 
Front Desk will display the HICAPS terminal ID in the HICAPS Terminal field. 
 
To test the communication between Front Desk and your HICAPS terminal, click 
Test.  If successful, a message will appear with the Response Code, Response Text, 
Merchant ID and Terminal ID. The Response Code should be “00” and Response 
Text should be “ECR COMMS - OK”, as below. 
 

 

Search button 
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Setting up HICAPS (System Information) 
 

If you will be using EFTPOS Integration you should enter the Provider / Merchant 
Numbers for EFTPOS by selecting them from the drop-down list, as below. 
 

 
 
To manually update Health Fund Card Details click Synchronise.  Note that this 
functionality has been provided for testing purposes, as Front Desk updates new 
Health Fund Details from the HICAPS terminal on start-up of Front Desk. 
 

 
 
By default, all HICAPS receipts will be printed through the HICAPS terminal. If you 
would prefer to print HICAPS receipts on A5 paper through your default Front Desk 
receipt printer, uncheck the Print HICAPS receipt on terminal option. Please note, 
EFTPOS and Medicare Easyclaim receipts will still be printed through the terminal. 
 

Front Desk 2021 - Note 
The Log transactions to file feature should only be used if instructed to do so by 
Smartsoft Pty Ltd or HICAPS personnel. 
 
To reduce the number of print outs when paying by HICAPS, select Don’t print 
regular receipts when billing HICAPS. 
 

Provider / Merchant 
Number s for EFTPOS 
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Setting up HICAPS (Item Codes) 
 

Select Item Codes on the toolbar 
 

 
 
or from the File menu. 
 

 
 
To create a new item code, click New. To edit an existing item code, double click the 
item code or highlight it and click OK. 
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Setting up HICAPS (Item Codes) 
 

Generally the item codes that you use for your professional services and the item 
codes accepted by HICAPS may vary.  If the Item Code is not the same as the 
HICAPS code, you will need to enter the valid information in the HICAPS Code field. 
 

Note: If the Item Code field already contains a valid HICAPS Code (e.g.001), 
then the HICAPS Code field can be left blank.  
 
If you have entered item codes that you know are not covered by health funds, check 
the Non-HICAPS Item option. These items will no longer be included in any HICAPS 
claim.  
 

 
 

Front Desk 2021 - Tip 
Make sure that either the Item Code field or the HICAPS Code field contains a valid 
HICAPS code.  Front Desk will use the HICAPS Code if one is entered, if not the 
Item Code will be used when submitting items to HICAPS.  
 

We recommend that you print an Item Codes Report to check your item codes 
details after updating them with the new HICAPS information.  To print an Item 
Codes Report, select Item Codes from the Reports menu. 
 

 

 

Non-HICAPS 
Item option 
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Setting up HICAPS (Practitioner) 
 

Select Practitioner from the toolbar 
 

 
 
or from the File menu. 
 

 
 
Double click the practitioner’s name, or highlight their name and click OK. 
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Setting up HICAPS (Practitioner) 
 

HICAPS requires a valid practitioner Provider Number to allow submission of a 
HICAPS claim.  Select the Provider numbers tab and make sure that the Default 
Provider Number is correct. If not, select the correct provider from the drop-down 
list. 
 

 
 
If you work in a multi-practitioner environment and use HICAPS integration, you may 
wish to record which practitioners are unable to claim a HICAPS rebate. 
 
Tick the No HICAPS claims for this Practitioner option. 
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Setting up HICAPS (Practitioner) 
 

Clinical Codes are part of the billing process required by health funds when 
processing transactions through the HICAPS interface for Dentists, Occupational 
Therapists and Psychologists.  For Dentists the Clinical Code equates to the Tooth 
Number.  Please note that this requirement does not currently apply to other 
health professionals. 
 
To include a Clinical Code when billing for a practitioner, go to the HICAPS tab in 
the Practitioner file.  Check the Include Clinical Code when Billing option then 
select the practitioner’s profession from the Profession drop-down list.  
 

 
 
A Clinical Code field will be displayed next to the Item Code on the receipt and 
billing screen for practitioners with this option enabled. 
 
When billing a patient, select the Clinical Code for the HICAPS claim.  If you place 
the cursor over the Clinical Code field a description will appear in the on-screen 
tooltip. 
 
 

 
 

Clinical Code 
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HICAPS - Additional Tab 
 

Select Patient from the toolbar 
 

 
 

or from the File menu. 
 

 
 
Go to the Additional tab on the patient file.  It is here that the patient’s health fund 
details are entered. 
 
When entering new patients with a valid health fund card, it will be an advantage to 
record the patient’s ID number on this card.  If there is only one person on the health 
fund card, this number will generally be 00.  For cards with more than one member, 
the ID for the first member will generally be 00, followed by 01 for the second 
member, 02 for the third member and so on. 
 

 
 
You can also enter the Health Fund and Member No.  These fields are optional for 
HICAPS and general billing. 

Health 
Fund 

Patient ID 
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HICAPS - Patient IDs 
 

For existing patients, you will be asked for the patient ID when submitting their first 
HICAPS claim through Front Desk.  This ID will then be stored in the patient file for 
subsequent use.  There is no need to go through all your existing patient files to enter 
their patient ID. 
 
When submitting a HICAPS claim for patients without a Patient ID entered, you will 
be prompted for this information as below. 
 
Select the patient’s ID number from the ID drop-down box and click OK.  If you wish 
to cancel the HICAPS claim at this point, click Cancel. 
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Receipting with HICAPS 
 

Receipting is a quick way to produce a receipt for one item only, which is to be paid 
in full. 
 
Click Receipt on the patient card or on the appointment book. 
 

 
 
Select the correct Date, Practitioner, and Item Code.  The default fee and reduction 
can be adjusted if necessary and a clinical code selected if applicable. 
 
Click OK to process the receipt. On the Payment screen click the HICAPS button to 
submit this transaction to HICAPS. 
 
If the patient does not have a patient ID entered you will be prompted to select one 
from the Health Fund Patient Numbers screen.  Use the ID drop-down box to select 
the number found on the patient’s health fund card. 
 

 

Patient ID 
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Receipting with HICAPS 
 

You will be prompted to swipe or insert the health fund card to begin the claim. 
 

 
 
After a few moments, the terminal will complete the transaction and Front Desk will 
show the benefit amount in the HICAPS field on the Payment Type screen. 
 
Enter the payment type of the remaining amount in the appropriate field e.g. cash, 
cheque, EFTPOS, and then click OK. 
 
If paying by EFTPOS enter the amount to be paid in the EFTPOS field and click the 
EFTPOS button.  You will then be asked to swipe the patient’s EFTPOS card. 
 

 
 
If you click Cancel at this stage, Front Desk will prompt you to swipe the patient’s 
card once more to cancel the submitted HICAPS claim. 
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Receipting with HICAPS 
 

If an error or problem occurred with the HICAPS claim, Front Desk will display this 
error and allow you to select an alternative payment method. 
 
Your printer / terminal will print out two copies of the HICAPS receipt: 
 

➢ A receipt for the practice to keep - provider copy (this copy must be signed by 
the patient) and 

➢ A receipt for the patient to keep - patient copy 
 
If the Print box is ticked on the receipt screen, a normal Front Desk receipt will also 
be printed for the patient. 
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Billing with HICAPS 
 

The Bill function can be used to perform the following functions  
 

• Receipt one or more items (bill and full payment) 

• Accepting a part payment for one or more items (Account/Receipt) 

• Billing a patient for one or more items with no payment (Account) 

• Processing transactions for one or more linked patients, e.g. a family 

• Making a payment greater than the amount being billed (transaction with an 
unallocated payment attached) 

 
Click Bill on the patient card or on the appointment book. 
 

 
 
Select the Practitioner, Date, Item Code and Clinical Code (if applicable) for the 
first item you wish to add.  Please note the Clinical Code field will only be visible 
when the Include Clinical Code when Billing option has been enabled for the 
billing Practitioner. This configuration only applies to Dentists, Psychologists and 
Occupational Therapists. 
 
From the payment drop-down box select No Payment, Full Payment, Gap Only, 
Rebate Only or HICAPS Only. 
 

Front Desk 2021 - Note 
The Gap Only option should only be used if fixed gap amounts have been entered in 
your item code. 
 
Click Add to add the item to the bill.  If required, select other items to be billed. 
  
Click OK to proceed.  If a HICAPS Only item exists, Front Desk will automatically 
start the process of submitting the claim to HICAPS for all items in the billing screen.  
If a HICAPS Only item is not included, you will be presented with the payment type 
screen with the option of submitting this claim to HICAPS by clicking the HICAPS 
button. 
 

Payment drop-
down box 
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Billing with HICAPS 
 

You will be prompted to swipe or insert the health fund card to begin the claim. 
 

 
 
If the patient does not have a patient ID entered, you will be prompted to select one 
from the Health Fund Patient Numbers window.  Use the ID drop-down box to 
select the number found on the patient’s health fund card and click OK to proceed. 
 
After a few moments, the terminal will complete the transaction, and Front Desk will 
show the benefit amount in the HICAPS field on the Payment Type screen. 
 
Enter the payment type of the remaining amount in the appropriate field, e.g. cash, 
cheque, EFTPOS, and then click OK. 
 
If paying by EFTPOS, enter the amount to be paid in the EFTPOS field and click the 
EFTPOS button.  You will then be asked to swipe/insert the patient’s EFTPOS card. 
 

 
 
If you click Cancel at this stage, Front Desk will prompt you to swipe or insert the 
patient’s card once more to cancel the submitted HICAPS claim. 
 

 



PAGE  109                                                                             FRONT DESK 2021 - PRACTICE MANAGEMENT SYSTEM 

HICAPS / EFTPOS INTEGRATION 

 
Billing with HICAPS 
 

If an error or problem occurred with the HICAPS claim, Front Desk will display this 
error and allow you to select an alternate payment method. 
 
Your printer / terminal will print two copies of the HICAPS receipt: 
 

➢ A receipt for the practice to keep - provider copy (this copy must be signed by 
the patient) and 

➢ A receipt for the patient to keep - patient copy 
 
If the Print box is ticked on the billing screen, a normal Front Desk receipt/account 
will also be printed for the patient. 
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Payments with HICAPS 
 

Payment is used to pay for an outstanding amount or to make an unallocated 
payment. 

 
Click Payment on the patient file. 
 

 
 
Enter the total amount to be paid in the Payment field. 
 
Either Auto Allocate the total to be paid to the outstanding amounts listed or 
manually allocate by using the payment drop-down boxes located in the allocation 
column of each outstanding item.  Select No Payment, Full Payment, Gap Only, 
Rebate Only or HICAPS Only. 
 
Click OK to proceed.  If a HICAPS Only item exists, Front Desk will automatically 
start the process of submitting the claim to HICAPS for all items in the billing screen.  
If a HICAPS Only item is not included, the payment type window will be displayed 
with the option of submitting this claim to HICAPS by clicking the HICAPS button. 
 
If the patient does not have a patient ID entered, you will be prompted to select one 
from the Health Fund Patient Numbers screen.  Use the ID drop-down box to select 
the number found on the patient’s health fund card and click OK to proceed. 
 

Payment drop-
down box 

Payment field 
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Quotes with HICAPS 

 
On the Quotations tab of the patient file, click New. 
 

 
 
The New Quotation window will be displayed. 
 

 
 
Select a Quotation Type from the drop-down list, add Notes (optional), and Add the 
items to the quotation. 
 
Click the HICAPS button to process a quote through the HICAPS terminal. 
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HICAPS Transactions 

 
To view and/or reverse HICAPS transactions, select HICAPS Transactions from the 
System menu. 
 

 
 
Select From and To dates to view a list of transactions for that period. 
 

 
 
Click the + symbol to the left of the transaction to view the details of that transaction. 
 
The patient’s name, item code and the HICAPS amount will be displayed for 
Approved transactions. 
 
The Processed Date/Time and the RRN (Retrieval Reference Number) will be 
displayed for Cancelled transactions. 
 
If Print HICAPS receipt on terminal is turned off in System Information, receipts 
can be reprinted by clicking the Reprint button. Receipts printed from the HICAPS 
Transactions window will be marked as duplicates.  

Reversal 
Button 
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HICAPS Transactions 

 
Click the Reversal button to reverse a HICAPS transaction.  You will be prompted by 
the following screen. 
 

 
 
Click Yes to proceed with the cancellation. 
 
You will be asked to swipe or insert the card. 
 

 
 
If successful, the following screen will appear. 
 

 
 

Front Desk 2021 - Note 
A transaction can only be reversed on the same day as it was submitted. You will 
need to swipe or insert the patient’s card to reverse a transaction. 
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WorkSafe Victoria Claiming 

 
To submit WorkSafe Victoria claims, it first needs to be enabled on the HICAPS / 
EFTPOS tab in System Information by checking Enable WorkSafe Victoria 
claiming. 
 

 
 
WorkSafe are not supplying its members with cards, so the claim number needs to 
be recorded on the patient’s file. Go to the Additional tab on the patient’s file and 
enter the WorkSafe Claim No in the field provided. 
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WorkSafe Victoria Claiming 

 
When processing HICAPS claims for WorkSafe Victoria patients, if a WorkSafe 
Claim No has been entered, the following message will be displayed. 
 

 
 
Click Yes to submit the claim to HICAPS. You will not be asked to swipe or insert the 
patient’s card. 
 
 

Front Desk 2021 - Note 
WorkSafe Victoria transactions will return no benefit at the time of processing, so a 
“Submitted” receipt will be printed if the claim is successful. The patient should make 
no other payment at the time. 
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Refunding an EFTPOS Payment 

 
To refund a patient an amount that was paid by EFTPOS, go to the System menu 
and select the EFTPOS Refund option. Deleting an EFTPOS payment from the 
Transactions tab on the patient file will also prompt to process an EFTPOS Refund. 
 

 
 
Enter the amount to refund and click OK. 
 

 
 
You will be prompted to swipe or insert the patient’s EFTPOS card. 
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Item Code 

HICAPS / EFTPOS INTEGRATION 
 

EFTPOS Surcharge 
 

For practices with an EFTPOS surcharge fee set up on their terminals, Front Desk 
will take this into account when recording the payment amount and when refunding 
EFTPOS amounts.  Users wishing to take advantage of this functionality need to set 
up a new item code to be used for an EFTPOS surcharge. This EFTPOS Surcharge 
Item Code should then be selected on the HICAPS/EFTPOS tab in System 
Information. 
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HICAPS Report 

 
To generate a HICAPS report, select HICAPS Report from the Reports menu. 
 

  
 
Select From and To dates. The filter section allows you to generate a report By 
Health Fund, By Practice Group, Reporting Group or Practitioner. 
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HICAPS Report 

 
There are four different ways to view the HICAPS report:     
 
Show totals only 
This option lists the totals of each health fund only. 
 
Breakdown totals by day 
This option shows each transaction by day.  This is the only option that allows the 
report to be grouped by either Health Fund or By Day. 
 
Show HICAPS Transactions 
This option lists the patient names and the HICAPS Transaction details. 
 
Show HICAPS Transactions and billing details 
This option lists the patient names, HICAPS transaction details and item codes. 
 
Health funds that make grouped payments known as "HICAPS Payment and 
Reconciliation Solution” are known in Front Desk as consolidated health funds. The 
list of consolidated funds can be viewed by clicking Consolidation. 
 

 
 
Smartsoft Pty Ltd will update the Consolidation list with software upgrades but from 
time to time you may need to manually add health funds to the consolidated group by 
checking the box to the right of the Health Fund name. 
 
The HICAPS report will group all consolidated health funds as per the "HICAPS 
Payment and Reconciliation Solution” to aid in reconciling HICAPS payments. 
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HICAPS / EFTPOS Security 
 

To provide access rights for users to view HICAPS Reports and to process EFTPOS 
Reversals, select Security from the System menu. 
 

 
 
Highlight the username and click Access. 
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EFTPOS Reversals 

HICAPS / EFTPOS INTEGRATION 

 
HICAPS / EFTPOS Security 
 

Check the HICAPS Reports option under the Reports / Exports tab to give the user 
access to these reports and the EFTPOS Reversals option under the General tab to 
give the user access to the refund EFTPOS payments functionality. 
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Tyro Integration (System Information) 
 

Tyro integration allows EFTPOS, HealthPoint (private health fund), and Medicare 
Easyclaim claims to be processed easily and efficiently using a Tyro terminal. 
 
Before we begin the setup of Tyro Integration, please ensure the following: 

 
▪ You have a list of HealthPoint item codes for your practice; 
▪ The Tyro terminal is turned on and connected to your network; 
▪ The Tyro Terminal Adapter (TTA) software has been installed and paired with 

your terminal. 
 

To enable Tyro integration, select Tyro on the Health Fund / EFTPOS / Medicare 
tab on the Advanced tab in System Information. 
 
Check Health Fund Claiming. EFTPOS Integration is a requirement for Tyro 
integration. This option will be automatically checked when selecting Tyro. 
 
If you will be processing Medicare Easyclaim claims through the Tyro terminal, check 
the Medicare Easyclaim Integration option. This option cannot be used on the 
same computer as Medicare / DVA Online Claiming. Contact Smartsoft for help 
deciding which option best suits your practice. 
 
If your terminal has multi-merchant functionality, you will need to check the Terminal 
is Multi-merchant option. 
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Tyro Integration (Item Codes) 
 

Click Item Codes on the toolbar 
 

 
 
or select Item Codes from the File menu. 
 

 
 
To create a new item code, click New. To edit an existing item code, double click the 
item code or highlight it and click OK. 
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Tyro Integration (Item Codes) 
 

Generally the item codes that you use for your professional services and the item 
codes accepted by Tyro HealthPoint may vary.  If the Item Code is not the same as 
the HealthPoint code, you will need to enter the valid information in the HealthPoint 
Code field. 
 

Note: If the Item Code field already contains a valid HealthPoint Code, then the 
HealthPoint Code field can be left blank.  
 
If you have entered item codes that you know are not covered by health funds, check 
the Non-HealthPoint Item option. These items will no longer be included in any Tyro 
HealthPoint claims.  
 

  
 

Front Desk 2021 - Tip 
Make sure that either the Item Code field or the HealthPoint Code field contains a 
valid HealthPoint code.  Front Desk will use the HealthPoint Code if one is entered, 
if not the Item Code will be used when submitting items to HealthPoint.  
 

We recommend that you print an Item Codes Report to check your item codes 
details after updating them with the new HealthPoint information.  To print an Item 
Codes Report, select Item Codes from the Reports menu. 
 

 
 

Non-
HealthPoint 
Item option 
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Tyro Integration (Practitioners) 
 

Click Practitioners from the toolbar 
 

 
 
or select Practitioners from the File menu. 
 

 
 
Double click the practitioner’s name, or highlight their name and click OK. 
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Tyro Integration (Practitioners) 
 

Tyro requires a valid practitioner Provider Number to allow submission of a 
HealthPoint claim.  Select the Provider Numbers tab and make sure that the 
Default Provider Number is correct. 
 

 
 
If you work in a multi-practitioner environment and use Tyro integration, you may 
wish to record which practitioners are unable to claim a private health fund rebate. To 
do this, check the No Tyro HealthPoint claims for this practitioner option on the 
Tyro tab. 
 
These professions can claim private health fund rebates through Tyro HealthPoint: 
 
Acupuncturists 
Chiropractors 
Dental technicians 
Dentists 
Dieticians 
Endodontists 
Exercise physiologists 
Massage therapists 
Naturopaths 
Occupational therapists 
Optical dispensers 
Optometrists 
Oral surgeons 
Orthodontists 
Osteopaths 
Paedodontists 
Periodontists 
Physiotherapists 
Podiatrists 
Prosthetists 
Prosthodontists 
Psychologists 
Speech pathologists. 
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Tyro Integration (Practitioners) 
 

 
 
On the Tyro tab, select the correct profession from the list. 
 
This must be selected for Tyro HealthPoint claims to be processed correctly. The 
profession also determines whether Clinical Codes (also known as service reference, 
body part, or tooth number) will be used when billing. Clinical Codes are required by 
health funds when processing transactions through Tyro HealthPoint for Dentists, 
Occupational Therapists, and Psychologists. 
 

 
 
If your Tyro terminal is multi-merchant enabled, you must enter the practitioner’s 
Merchant ID on this page. 
 

Front Desk 2021 - Note 
Other dental professions also require Clinical Codes when billing. These professions 
are: dental technicians, endodontists, oral surgeons, orthodontists, paedodontists, 
periodontists, and prosthodontists. 
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Tyro Integration (Practitioners) 
 

A Clinical Code field will be displayed next to the Item Code on the receipt and 
billing screen for practitioners with this option enabled. 
 
When billing a patient, select the Clinical Code for the Tyro HealthPoint claim.  If you 
place the cursor over the Clinical Code field a description will appear in the on-
screen tooltip. 
 
 

 

Clinical Code 
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Tyro Integration (Patients) 
 

Click Patient on the toolbar 
 

 
 
or select Patient from the File menu. 
 

 
 
Go to the Additional tab on the patient file.  It is here that the patient’s health fund 
details are entered. 
 
When entering new patients with a valid health fund card, it is advantageous to 
record the patient’s ID number on this card.  If there is only one person on the health 
fund card, this number will generally be 00.  For cards with more than one member, 
the ID for the first member will generally be 00, followed by 01 for the second 
member, 02 for the third member and so on. 
 

 
 
You can also enter the Health Fund and Member No.  These fields are optional for 
Tyro HealthPoint and general billing. 

Health 
Fund 

Patient ID 
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Tyro Integration (Patients) 
 

For existing patients, you will be asked for the patient ID when submitting their first 
Tyro HealthPoint claim through Front Desk.  This ID will then be stored in the patient 
file for subsequent use.  There is no need to go through all of your existing patient 
files to enter their patient IDs. 
 
When submitting a Tyro HealthPoint claim for patients without a Patient ID entered, 
you will be prompted for this information as below. 
 
Select the patient’s ID number from the ID drop-down box and click OK.  If you wish 
to cancel the Tyro HealthPoint claim at this point, click Cancel. 
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Tyro HealthPoint Integration (Receipting) 
 

Receipting is a quick way to produce a receipt for one item only, which is to be paid 
in full. 
 
Click Receipt on the patient card or on the appointment book. 
 

 
 
Select the correct Date, Practitioner, and Item Code.  The default fee and reduction 
can be adjusted if necessary and a clinical code selected if applicable. 
 
Click OK to process the receipt. On the Payment screen click the HealthPoint 
button to submit this transaction to HealthPoint. 
 
If the patient does not have a patient ID entered you will be prompted to select one 
from the Health Fund Patient Numbers screen.  Use the ID drop-down box to select 
the number found on the patient’s health fund card. 
 

 

Patient ID 
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Tyro HealthPoint Integration (Receipting) 
 

You will be prompted to swipe or insert the health fund card to begin the claim. 
 

 
 
After a few moments the following screen will be displayed. Click Accept to accept 
the benefit. 
 

 
 
Once accepted, Front Desk will display the benefit amount and the response from the 
terminal. The benefit will also be shown in the HealthPoint field on the Payment 
Type screen. 
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Tyro HealthPoint Integration (Receipting) 
 

 
 
Enter the payment type of the remaining amount in the appropriate field e.g. cash, 
cheque, EFTPOS, and then click OK. 
 
If paying the gap by EFTPOS, enter the amount to be paid in the EFTPOS field and 
click the EFTPOS button. 
 

 
 
You will then be asked to swipe the patient’s EFTPOS card. 
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Tyro HealthPoint Integration (Receipting) 
 

If the EFTPOS purchase is approved, you will see the following messages. 
 

 
 

 
 
If you click Cancel at this stage, Front Desk will prompt you to swipe the patient’s 
cards once more to cancel / refund the submitted HealthPoint claim / EFTPOS 
purchase. 
 
If an error or problem occurred with the HealthPoint claim, Front Desk will display this 
error and allow you to select an alternative payment method. 
 
If the Print box is ticked on the receipt screen, a normal Front Desk receipt will also 
be printed for the patient. 
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Tyro HealthPoint Integration (Billing) 
 

The Bill function can be used to perform the following functions  
 

• Receipt one or more items (bill and full payment) 

• Accepting a part payment for one or more items (Account/Receipt) 

• Billing a patient for one or more items with no payment (Account) 

• Processing transactions for one or more linked patients, e.g. a family 

• Making a payment greater than the amount being billed (transaction with an 
unallocated payment attached) 

 
Click Bill on the patient card or on the appointment book. 
 

 
 
Select the Practitioner, Date, Item Code and Clinical Code (if applicable) for the 
first item you wish to add.  Please note the Clinical Code field will only be visible 
when billing Dentists, Psychologists and Occupational Therapists. 
 
From the payment drop-down box select No Payment, Full Payment, Gap Only, 
Rebate Only or Tyro Only. 
 

Front Desk 2021 - Note 
The Gap Only and Rebate Only options should only be used if fixed gap amounts 
have been entered in your item code. 
 
Click Add to add the item to the bill.  If required, select other items to be billed. 
  
Click OK to proceed.  You will be presented with the payment type screen with the 
option of submitting this claim to Tyro HealthPoint by clicking the HealthPoint button. 
 

Payment drop-
down box 
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Tyro HealthPoint Integration (Billing) 
 

If the patient does not have a patient ID entered, you will be prompted to select one 
from the Health Fund Patient Numbers window.  Use the ID drop-down box to 
select the number found on the patient’s health fund card and click OK to proceed. 
 
You will be prompted to swipe or insert the health fund card to begin the claim. 
 

 
 
After a few moments the following screen will be displayed. Click Accept to accept 
the benefit. 
 

 
 
Once accepted, Front Desk will display the benefit amount and the response from the 
terminal. The benefit will also be shown in the HealthPoint field on the Payment 
Type screen. 
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Tyro HealthPoint Integration (Billing) 
 

Enter the payment type of the remaining amount in the appropriate field, e.g. cash, 
cheque, EFTPOS, and then click OK. 
 
If paying the gap by EFTPOS, enter the amount to be paid in the EFTPOS field and 
click the EFTPOS button. 
 

 
 
You will then be asked to swipe the patient’s EFTPOS card. 
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Tyro HealthPoint Integration (Billing) 
 

If the EFTPOS purchase is approved, you will see the following messages. 
 

 
 

 
 
If you click Cancel at this stage, Front Desk will prompt you to swipe the patient’s 
cards once more to cancel / refund the submitted HealthPoint claim / EFTPOS 
purchase. 
 
If an error or problem occurred with the HealthPoint claim, Front Desk will display this 
error and allow you to select an alternative payment method. 
 
If the Print box is ticked on the receipt screen, a normal Front Desk receipt will also 
be printed for the patient. 
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Tyro HealthPoint Integration (Payment) 
 

Payment is used to pay for an outstanding amount or to make an unallocated 
payment. 

 
Click Payment on the patient file. 
 

 
 
Enter the total amount to be paid in the Payment field. 
 
Either Auto Allocate the total to be paid to the outstanding amounts listed or 
manually allocate by using the payment drop-down boxes located in the allocation 
column of each outstanding item.  Select No Payment, Full Payment, or Gap Only. 
 
Click OK to proceed.  The payment type window will be displayed with the option of 
submitting this claim to Tyro HealthPoint by clicking the HealthPoint button. 
 
If the patient does not have a patient ID entered, you will be prompted to select one 
from the Health Fund Patient Numbers screen.  Use the ID drop-down box to select 
the number found on the patient’s health fund card and click OK to proceed. 

Payment drop-
down box 

Payment field 
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Tyro Transactions 
 

To view Tyro EFTPOS and HealthPoint transactions, select Tyro Transactions from 
the System menu. This is also where transactions can be refunded or cancelled. 
 

 
 
Select From and To dates to view a list of transactions for that period. 
 

  
 
 
Scroll to the right to see more details of the transaction, e.g. Transaction Reference, 
Authorisation Code, and Card Type. 
 
Click the + symbol to the left of the transaction to view the details of that transaction. 
 
The patient’s name, item code and the benefit amount will be displayed for 
APPROVED transactions. 
 

Refund / Cancel button 



PAGE  141                                                                             FRONT DESK 2021 - PRACTICE MANAGEMENT SYSTEM 

TYRO INTEGRATION 

  
Tyro Transactions (EFTPOS Refunds / Healthpoint Cancellations) 
 

Click the Refund button to refund an EFTPOS Purchase. You will be prompted with 
the following screen. 
 

 
 
The maximum Refund Amount that can be set is the original purchase amount. If 
refunds have already been processed for the transaction, the maximum refund will be 
the remaining amount. 
 
Click OK to proceed with the refund. 
 
You will be asked to swipe or insert the card and select the account. You may be 
asked to enter a refund password on the Tyro terminal. 
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Tyro Transactions (EFTPOS Refunds / HealthPoint Cancellations) 
 

If successful, the following messages will be displayed. 

 

 
 

 
 
Click the Cancel button to cancel a HealthPoint Claim. You will be prompted with the 
following screen. 
 

 
 
Click Yes to proceed with the refund. 
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Tyro Transactions (HealthPoint Cancellations) 
 

You will be asked to swipe the patient’s health fund card. 

 

 
 
If successful, the following message will be displayed. 
 

 
 

Front Desk 2021 - Note 
You can also refund Tyro EFTPOS purchases or cancel Tyro HealthPoint claims by 
deleting the associated transactions from the Transactions tab on the patient’s file. 
 
 

Front Desk 2021 - Note 
A HealthPoint Claim can only be reversed on the same day as it was submitted. You 
will need to swipe the patient’s card to cancel a claim. 
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 Refunding an EFTPOS Payment 
 

To refund an EFTPOS payment without removing the payment from the patient’s file 
in Front Desk, go to the System menu and select the EFTPOS Refund option.  
 

 
 
Enter the amount to refund and click OK. 
 

 
 
You will be prompted to enter an admin password on the Tyro terminal, and then to 
swipe the patient’s EFTPOS card and select an account. 
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Refunding an EFTPOS Payment 
 

 
 

 
 
If the refund is APPROVED Front Desk will display the following message. 
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Tyro HealthPoint Report 
 

Select Tyro HealthPoint Report from the Reports menu. 
 

  
 
Select From and To dates. The filter section allows you to generate a report By 
Health Fund, By Practice or By Location. 
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Tyro HealthPoint Report 
 

There are four different ways to view the Tyro HealthPoint report:     
 
Show totals only 
This option lists the totals of each health fund only. 
 
Breakdown totals by day 
This option shows each transaction by day.  This is the only option that allows the 
report to be grouped by either Health Fund or Day. 
 
Show HealthPoint transactions 
This option lists the patient names and the Tyro HealthPoint transaction details. 
 
Show HealthPoint transactions / billing details 
This option lists the patient names, Tyro HealthPoint transaction details and item 
codes. 
 
Health funds whose payments are settled in a single HealthPoint payment to the 
clinic are known in Front Desk as consolidated health funds. The list of consolidated 
funds can be viewed by clicking the Consolidation button. 
 

 
 
Smartsoft Pty Ltd will update the Consolidation list with software upgrades, but from 
time to time you may need to manually add health funds to the consolidated group by 
ticking the box to the right of the Health Fund name. 
 
The Tyro HealthPoint report will group all consolidated health funds to aid in 
reconciling HealthPoint payments. 
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ANZ HealthPay Integration (System Information) 
 

ANZ HealthPay integration allows EFTPOS, HealthPoint (private health fund), and 
Medicare Easyclaim claims to be processed easily and efficiently using an ANZ 
terminal. 
 
Before we begin the setup of ANZ HealthPay integration, please ensure the 
following: 

 
▪ You have a list of HealthPoint item codes for your practice; 
▪ The ANZ terminal is turned on and connected to your network; 
▪ The ANZ HealthPay software has been installed and paired with your 

terminal. 
 

To enable ANZ HealthPay integration, select ANZ HealthPay on the Health Fund / 
EFTPOS / Medicare tab on the Advanced tab in System Information. 
 
Check Health Fund Claiming (and EFTPOS Integration if you wish to process 
EFTPOS payments through the ANZ terminal). 
 
If you will be processing Medicare Easyclaim claims through the ANZ terminal, check 
the Medicare Easyclaim Integration option. This option cannot be used on the 
same computer as Medicare / DVA Online Claiming. Contact Smartsoft for help 
deciding which option best suits your practice. 
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ANZ HealthPay Integration (System Information) 
 

Once ANZ HealthPay enabled in the Advanced settings you will be prompted to 
restart Front Desk. After restarting Front Desk the ANZ HealthPay tab will become 
available from System Information. 
 

 
 
Click Activate Device to activate your terminal on this computer. This will prompt 
you to enter a Secret Key provided by ANZ. 
 
Enter your secret key then click Activate. 
 

 
 
Click Setup Device to enter your Private Health Claiming ID, which is also provided 
by ANZ. 
 
Enter your claiming ID and click Setup Device. 
 

 
 
If your terminal has been installed correctly these should both complete successfully. 
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ANZ HealthPay Integration (Item Codes) 
 

Click Item Codes on the toolbar 
 

 
 
or select Item Codes from the File menu. 
 

 
 
To create a new item code, click New. To edit an existing item code, double click the 
item code or highlight it and click OK. 
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ANZ HealthPay Integration (Item Codes) 
 

Generally the item codes that you use for your professional services and the item 
codes accepted by ANZ HealthPay may vary.  If the Item Code is not the same as 
the HealthPoint code, you will need to enter the valid information in the HealthPoint 
Code field. 
 

Note: If the Item Code field already contains a valid HealthPoint Code, then the 
HealthPoint Code field can be left blank.  
 
If you have entered item codes that you know are not covered by health funds, check 
the Non-HealthPoint Item option. These items will no longer be included in any ANZ 
HealthPay claims.  
 

  
 

Front Desk 2021 - Tip 
Make sure that either the Item Code field or the HealthPoint Code field contains a 
valid HealthPoint code.  Front Desk will use the HealthPoint Code if one is entered, 
if not the Item Code will be used when submitting items to HealthPoint.  
 

We recommend that you print an Item Codes Report to check your item codes 
details after updating them with the new HealthPoint information.  To print an Item 
Codes Report, select Item Codes from the Reports menu. 
 

 
 

Non-
HealthPoint 
Item option 
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ANZ HealthPay Integration (Practitioners) 
 

Click Practitioners from the toolbar 
 

 
 
or select Practitioners from the File menu. 
 

 
 
Double click the practitioner’s name, or highlight their name and click OK. 
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ANZ HealthPay Integration (Practitioners) 
 

ANZ requires a valid practitioner Provider Number to allow submission of a 
HealthPay claim.  Select the Provider Numbers tab and make sure that the Default 
Provider Number is correct. 
 

 
 
If you work in a multi-practitioner environment and use ANZ HealthPay integration, 
you may wish to record which practitioners are unable to claim a private health fund 
rebate. To do this, check the No ANZ HealthPay claims for this practitioner option 
on the ANZ HealthPay tab. 
 
These professions can claim private health fund rebates through ANZ HealthPay: 
 
Acupuncturists 
Chiropractors 
Dental technicians 
Dentists 
Dieticians 
Endodontists 
Exercise physiologists 
Massage therapists 
Naturopaths 
Occupational therapists 
Optical dispensers 
Optometrists 
Oral surgeons 
Orthodontists 
Osteopaths 
Paedodontists 
Periodontists 
Physiotherapists 
Podiatrists 
Prosthetists 
Prosthodontists 
Psychologists 
Speech pathologists. 
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ANZ HealthPay Integration (Practitioners) 
 

 
 
On the ANZ HealthPay tab, select the correct profession from the list. 
 
This must be selected for ANZ HealthPay claims to be processed correctly. The 
profession also determines whether Clinical Codes (also known as service reference, 
body part, or tooth number) will be used when billing. Clinical Codes are required by 
health funds when processing transactions through ANZ HealthPoint for Dentists, 
Occupational Therapists, and Psychologists. 
 

 
 
If your ANZ terminal is multi-merchant enabled, you must enter the practitioner’s 
Merchant ID on this page. 
 

Front Desk 2021 - Note 
Other dental professions also require Clinical Codes when billing. These professions 
are: dental technicians, endodontists, oral surgeons, orthodontists, paedodontists, 
periodontists, and prosthodontists. 
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ANZ HealthPay Integration (Practitioners) 

 
A Clinical Code field will be displayed next to the Item Code on the receipt and 
billing screen for practitioners with this option enabled. 
 
When billing a patient, select the Clinical Code for the ANZ HealthPay claim.  If you 
place the cursor over the Clinical Code field a description will appear in the on-
screen tooltip. 
 
 

 

Clinical Code 
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ANZ HealthPay Integration (Patients) 
 

Click Patient on the toolbar 
 

 
 
or select Patient from the File menu. 
 

 
 
Go to the Additional tab on the patient file.  It is here that the patient’s health fund 
details are entered. 
 
When entering new patients with a valid health fund card, it is advantageous to 
record the patient’s ID number on this card.  If there is only one person on the health 
fund card, this number will generally be 00.  For cards with more than one member, 
the ID for the first member will generally be 00, followed by 01 for the second 
member, 02 for the third member and so on. 
 

 
 
You can also enter the Health Fund and Member No.  These fields are optional for 
ANZ HealthPay and general billing. 

Health 
Fund 

Patient ID 
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ANZ HealthPay Integration (Patients) 

 
For existing patients, you will be asked for the patient ID when submitting their first 
ANZ HealthPay claim through Front Desk.  This ID will then be stored in the patient 
file for subsequent use.  There is no need to go through all of your existing patient 
files to enter their patient IDs. 
 
When submitting a ANZ HealthPay claim for patients without a Patient ID entered, 
you will be prompted for this information as below. 
 
Select the patient’s ID number from the ID drop-down box and click OK.  If you wish 
to cancel the ANZ HealthPay claim at this point, click Cancel. 
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ANZ HealthPay Integration (Receipting) 

 
Receipting is a quick way to produce a receipt for one item only, which is to be paid 
in full. 
 
Click Receipt on the patient card or on the appointment book. 
 

 
 
Select the correct Date, Practitioner, and Item Code.  The default fee and reduction 
can be adjusted if necessary and a clinical code selected if applicable. 
 
Click OK to process the receipt. On the Payment screen click the HealthPoint 
button to submit this transaction to HealthPoint. 
 
If the patient does not have a patient ID entered you will be prompted to select one 
from the Health Fund Patient Numbers screen.  Use the ID drop-down box to select 
the number found on the patient’s health fund card. 
 

 

Patient ID 
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ANZ HealthPay Integration (Receipting) 

 
You will be prompted to swipe or insert the health fund card to begin the claim. 
 

 
 
After a few moments the following screen will be displayed. Click Accept to accept 
the benefit. 
 

 
 
Once accepted, Front Desk will display the benefit amount and the response from the 
terminal. The benefit will also be shown in the HealthPoint field on the Payment 
Type screen. 
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ANZ HealthPay Integration (Receipting) 

 

 
 
Enter the payment type of the remaining amount in the appropriate field e.g. cash, 
cheque, EFTPOS, and then click OK. 
 
If paying the gap by EFTPOS, enter the amount to be paid in the EFTPOS field and 
click the EFTPOS button. 
 

 
 
You will then be asked to swipe the patient’s EFTPOS card. 
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ANZ HealthPay Integration (Receipting) 

 
If the EFTPOS purchase is approved, you will see the following messages. 
 

 
 

 
 
If you click Cancel at this stage, Front Desk will prompt you to swipe the patient’s 
cards once more to cancel / refund the submitted HealthPoint claim / EFTPOS 
purchase. 
 
If an error or problem occurred with the HealthPoint claim, Front Desk will display this 
error and allow you to select an alternative payment method. 
 
If the Print box is ticked on the receipt screen, a normal Front Desk receipt will also 
be printed for the patient. 
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ANZ HealthPay Integration (Billing) 

 
The Bill function can be used to perform the following functions  
 

• Receipt one or more items (bill and full payment) 

• Accepting a part payment for one or more items (Account/Receipt) 

• Billing a patient for one or more items with no payment (Account) 

• Processing transactions for one or more linked patients, e.g. a family 

• Making a payment greater than the amount being billed (transaction with an 
unallocated payment attached) 

 
Click Bill on the patient card or on the appointment book. 
 

 
 
Select the Practitioner, Date, Item Code and Clinical Code (if applicable) for the 
first item you wish to add.  Please note the Clinical Code field will only be visible 
when billing Dentists, Psychologists and Occupational Therapists. 
 
From the payment drop-down box select No Payment, Full Payment, Gap Only, 
Rebate Only or ANZ HealthPay Only. 
 

Front Desk 2021 - Note 
The Gap Only and Rebate Only options should only be used if fixed gap amounts 
have been entered in your item code. 
 
Click Add to add the item to the bill.  If required, select other items to be billed. 
  
Click OK to proceed.  You will be presented with the payment type screen with the 
option of submitting this claim to ANZ HealthPoint by clicking the HealthPoint button. 
 

Payment drop-
down box 
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ANZ HealthPay Integration (Billing) 

 
If the patient does not have a patient ID entered, you will be prompted to select one 
from the Health Fund Patient Numbers window.  Use the ID drop-down box to 
select the number found on the patient’s health fund card and click OK to proceed. 
 
You will be prompted to swipe or insert the health fund card to begin the claim. 
 

 
 
After a few moments the following screen will be displayed. Click Accept to accept 
the benefit. 
 

 
 
Once accepted, Front Desk will display the benefit amount and the response from the 
terminal. The benefit will also be shown in the HealthPoint field on the Payment 
Type screen. 
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ANZ HealthPay Integration (Billing) 

 
Enter the payment type of the remaining amount in the appropriate field, e.g. cash, 
cheque, EFTPOS, and then click OK. 
 
If paying the gap by EFTPOS, enter the amount to be paid in the EFTPOS field and 
click the EFTPOS button. 
 

 
 
You will then be asked to swipe the patient’s EFTPOS card. 
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ANZ HealthPay Integration (Billing) 
 

If the EFTPOS purchase is approved, you will see the following messages. 
 

 
 

 
 
If you click Cancel at this stage, Front Desk will prompt you to swipe the patient’s 
cards once more to cancel / refund the submitted HealthPoint claim / EFTPOS 
purchase. 
 
If an error or problem occurred with the HealthPoint claim, Front Desk will display this 
error and allow you to select an alternative payment method. 
 
If the Print box is ticked on the receipt screen, a normal Front Desk receipt will also 
be printed for the patient. 
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ANZ HealthPay Integration (Payment) 

 
Payment is used to pay for an outstanding amount or to make an unallocated 
payment. 

 
Click Payment on the patient file. 
 

 
 
Enter the total amount to be paid in the Payment field. 
 
Either Auto Allocate the total to be paid to the outstanding amounts listed or 
manually allocate by using the payment drop-down boxes located in the allocation 
column of each outstanding item.  Select No Payment, Full Payment, or Gap Only. 
 
Click OK to proceed.  The payment type window will be displayed with the option of 
submitting this claim to ANZ HealthPoint by clicking the ANZ HealthPay button. 
 
If the patient does not have a patient ID entered, you will be prompted to select one 
from the Health Fund Patient Numbers screen.  Use the ID drop-down box to select 
the number found on the patient’s health fund card and click OK to proceed. 

Payment drop-
down box 

Payment field 
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ANZ HealthPay Transactions 

 
To view Tyro EFTPOS and HealthPoint transactions, select ANZ HealthPay 
Transactions from the System menu. This is also where transactions can be 
refunded or cancelled. 
 

 
 
Select From and To dates to view a list of transactions for that period. 
 

  
 
 
Scroll to the right to see more details of the transaction, e.g. Transaction Reference, 
Authorisation Code, and Card Type. 
 
Click the + symbol to the left of the transaction to view the details of that transaction. 
 
The patient’s name, item code and the benefit amount will be displayed for 
APPROVED transactions. 
 

Refund / Cancel button 
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ANZ HealthPay Transactions (EFTPOS Refunds / HealthPay 
Cancellations) 

 
Click the Refund button to refund an EFTPOS Purchase. You will be prompted with 
the following screen. 
 

 
 
The maximum Refund Amount that can be set is the original purchase amount. If 
refunds have already been processed for the transaction, the maximum refund will be 
the remaining amount. 
 
Click OK to proceed with the refund. 
 
You will be asked to swipe or insert the card and select the account. You may be 
asked to enter a refund password on the Tyro terminal. 
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ANZ HealthPay Transactions (EFTPOS Refunds / HealthPoint 
Cancellations) 

 
If successful, the following messages will be displayed. 

 

 
 

 
 
Click the Cancel button to cancel a HealthPoint Claim. You will be prompted with the 
following screen. 
 

 
 
Click Yes to proceed with the refund. 
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ANZ HealthPay Transactions (HealthPoint Cancellations) 
 

You will be asked to swipe the patient’s health fund card. 

 

 
 
If successful, the following message will be displayed. 
 

 
 

Front Desk 2021 - Note 
You can also refund Tyro EFTPOS purchases or cancel Tyro HealthPoint claims by 
deleting the associated transactions from the Transactions tab on the patient’s file. 
 
 

Front Desk 2021 - Note 
A HealthPoint Claim can only be reversed on the same day as it was submitted. You 
will need to swipe the patient’s card to cancel a claim. 
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 Refunding an EFTPOS Payment 

 
To refund an EFTPOS payment without removing the payment from the patient’s file 
in Front Desk, go to the System menu and select the EFTPOS Refund option.  
 

 
 
Enter the amount to refund and click OK. 
 

 
 
You will be prompted to enter an admin password on the Tyro terminal, and then to 
swipe the patient’s EFTPOS card and select an account. 
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Refunding an EFTPOS Payment 

 

 
 

 
 
If the refund is APPROVED Front Desk will display the following message. 
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ANZ HealthPay Report 
 

Select ANZ HealthPay Report from the Reports menu. 
 

  
 
Select From and To dates. The filter section allows you to generate a report By 
Health Fund, By Practice or By Location. 
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ANZ HealthPay Report 
 

There are four different ways to view the ANZ HealthPoint report:     
 
Show totals only 
This option lists the totals of each health fund only. 
 
Breakdown totals by day 
This option shows each transaction by day.  This is the only option that allows the 
report to be grouped by either Health Fund or Day. 
 
Show HealthPoint transactions 
This option lists the patient names and the Tyro HealthPoint transaction details. 
 
Show HealthPoint transactions / billing details 
This option lists the patient names, Tyro HealthPoint transaction details and item 
codes. 
 
Health funds whose payments are settled in a single HealthPoint payment to the 
clinic are known in Front Desk as consolidated health funds. The list of consolidated 
funds can be viewed by clicking the Consolidation button. 
 

 
 
Smartsoft Pty Ltd will update the Consolidation list with software upgrades, but from 
time to time you may need to manually add health funds to the consolidated group by 
ticking the box to the right of the Health Fund name. 
 
The Tyro HealthPoint report will group all consolidated health funds to aid in 
reconciling HealthPoint payments. 
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MEDICARE EASYCLAIM INTEGRATION 
 

Medicare Easyclaim 
 
Medicare Easyclaim is a way of submitting claims to Medicare using the HICAPS or 
Tyro terminal. 
 
There are two types of claim that can be submitted using Medicare Easyclaim. These 
are: 
 
Patient Claims (which can be either Fully Paid, Part Paid or Unpaid); and 
Bulk Bill Claims 
 
Medicare Easyclaim Integration can be enabled on the Health Fund / EFTPOS / 
Medicare tab on the Advanced tab in System Information. 
 

 
 
 
 
 
 
 

Front Desk 2021 - Note 
It is not possible to enable Medicare Easyclaim Integration and Medicare / DVA 
Online Claiming in Front Desk at the same time.  Practices must choose which 
solution best fits their needs. 
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Patient Details 
 
A patient’s Medicare details can be added on the Medicare / DVA tab of the patient’s 
file. 
 

 
 
HICAPS 
If the Medicare No is entered, it will be used when submitting the claim. If a 
Medicare No has not been recorded on the patient’s file, the patient will be asked to 
swipe their Medicare card in the HICAPS terminal at the time of claiming. 
 
Tyro 
A Medicare No must be entered before submitting the claim.  
 
If the patient will not be the one claiming the rebate from Medicare, check Alternate 
Claimant and either search for a patient in the database, or enter the details in the 
fields provided. 
 
 

Medicare 
Number 
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Referral Details 
 
For most Medicare claims, a Referral must be entered. This information is usually 
entered on the Billing Details tab of the patient’s file. 
 

 
 
Check Referring Doctor in the Print on Accounts section. The Ref. Dr field will 
become active. 
 

Click the  button to search for a Referring Doctor. 
 

 
 
Highlight the correct Referrer and click OK. If the Referring Doctor is not in the list, 
click New to enter the correct details. 
 

Front Desk 2021 - Note 
The Referring Doctor’s name and provider number must be entered, otherwise a 
claim cannot be processed. 
 

Referring 
doctor 
details 

 
 
 

Activate 
referring 
doctor 
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Referral Details 
 
Click More... to enter the referral start and end dates. 
 

 
 
If the practice is using Medical Specialist Referrals, referrals are entered on the 
Medical Referrals tab of the patient’s file. 
 

 
 

Front Desk 2021 - Note 
Medical Specialist Referrals is an extended functionality for medical specialists. It is 
generally not recommended for allied health professionals, who should be using the 
Ref. Dr. field on the Billing Details tab. 
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Practitioner Details 

 
Select Practitioners from the toolbar. 
 

 
 
Select a practitioner’s name and click OK. 
 
Go to the Provider Numbers tab. Check that a Default Provider Number has been 
entered for the practitioner. If this field is empty, select a provider number from the 
drop-down list. 
 

 
 
Go to the Medicare tab on the practitioner’s file. 
 

 
 
A Payee Provider is a practitioner who is paid by Medicare for services they, or 
other practitioners, have provided. If payment should go to a different practitioner, 
check Use alternate Payee Provider and select a practitioner from the drop-down 
list. 
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Item Codes 
 
Only items which have been marked as Medicare / DVA items can be claimed 
through Medicare Easyclaim.  
 

 
 
Select Item Codes from the toolbar. 
 
Click the item you wish to edit, and click OK. 
 

 
 
Check the Medicare / DVA Item option and click Close to save your changes. 
 
 

Medicare / 
DVA item 
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Patient Claiming from Receipt 
 
When processing a receipt for a patient, check the Medicare Easyclaim option. 
 

 
 
Record the payment details. 
 

 
 

Front Desk 2021 - Note 
After checking the Medicare Easyclaim option, the HICAPS / Tyro HealthPoint 
button will be disabled. Patients cannot claim the same item from both Medicare and 
their health fund. 
 
Click OK. 
 
After payment has been taken, the Medicare Easyclaim Wizard will be displayed. 
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Patient Claiming from Receipt 
 

 
 
The first page displays patient information and a list of the items to be claimed 

through Medicare. Clicking on the  button allows additional information to be 
entered about the claim. 
 

 
 
Select any relevant options and click OK to return to the Wizard. 
 
Click Next to continue to the next page. 
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Patient Claiming from Receipt 
 

 
 
The Easyclaim - Referral Details page is displayed. If referral details were entered 
for the patient these will be displayed here. If there are no referral details then the No 
referral details available option will be selected, and a reason must be selected 
from the list. 
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Patient Claiming from Receipt 
 
Click Next to continue to the next page. 
 

 
 
The next page allows Claimant Details to be entered. If the patient will not be the 
one claiming the rebate from Medicare, select Use alternate claimant details. This 
will automatically display claimant details if they have been entered on the patient’s 
file, or it will allow users to search for a claimant. This option would typically be used 
in the case where a child is the patient, and the rebate will be sent to a parent. 
 
 
Click Next to continue to the next page. 
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Patient Claiming from Receipt 
 

 
 
Click Submit to send the claim to the terminal. 
 
HICAPS 
If a Medicare number has not been entered, the patient will be asked to swipe their 
Medicare card. 
 
Follow the prompts on the terminal (also displayed on the screen). 
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Patient Claiming from Receipt 
 
Tyro 

 
 
All Medicare Easyclaim claims submitted using the Receipt function will be Fully 
Paid claims, meaning the rebate will be paid to the patient. 
 
HICAPS 
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Patient Claiming from Receipt 
 
If the claim is successful the patient will be asked to swipe or insert their EFTPOS 
card so that the rebate can be paid to their EFTPOS account. 
 
HICAPS 

 
 
Tyro 

 
 
Follow the prompts on the terminal to accept the rebate payment. 
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Patient Claiming from Receipt 
 
HICAPS 

 
 
Tyro 
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Patient Claiming from Receipt 
 
If the claim is approved, the following message will be displayed. 

 
HICAPS 

 
 
Tyro 

 
 
Declined claims will display a code and description, returned by the terminal. 
 
HICAPS 

 
 
Tyro 

 
 

Front Desk 2021 - Note 
All Medicare Easyclaim receipts will be printed through the HICAPS terminal. 
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Patient Claiming from Billing 
 

 
 
Check the Medicare Easyclaim option. 
 
A Fully Paid, Part Paid, or Unpaid claim will be created. This depends on the 
payment options selected on the Billing screen. 
 
Follow the prompts on the terminal, as described in the Patient Claiming from 
Receipt section. 
 
 



PAGE  191                                                                             FRONT DESK 2021 - PRACTICE MANAGEMENT SYSTEM 

MEDICARE EASYCLAIM INTEGRATION 
 

Bulk Bill from Billing 
 

 
 
Check the Bulk Bill option. 
 
Note: this option is only available when no payment has been made.  
 
Click OK. The Medicare Easyclaim Wizard will be displayed. 
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Bulk Bill from Billing 
 
Click Next to continue. 
 

 
 
The Easyclaim - Referral Details page is displayed. 
 
Click Next to continue. The Submit Claim page is displayed. 
 
HICAPS 
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Bulk Bill from Billing 
 
Tyro 

 
 
If the patient has assigned their right to benefit before seeing the practitioner, check 
The patient has assigned their right to a Medicare benefit to the servicing 
provider. This is used in practices where the patient signs for the claim prior to their 
appointment and does not return to reception afterwards. 
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Bulk Bill from Billing 
 
Click Submit to send the claim to the terminal. 
 
Follow the prompts on the terminal. These will also be displayed on your screen. 
 
HICAPS 

 
 
Tyro 
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Bulk Bill from Billing 
 
If the bulk bill claim has been approved, the provider will be asked if they wish to 
accept the benefit. 
 
HICAPS 

 
 
Tyro 
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Bulk Bill from Billing 
 
Tyro 
If the patient hasn’t previously assigned their right to benefit, the following question 
will be displayed. 
 

 
 
Once complete, the user will be asked if they would like to print a copy of the receipt. 
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Bulk Bill from Billing 
 
The following message will then be displayed. 
 
HICAPS 

 
 
Tyro 

 
 
 
If the bulk bill claim is declined, the following messages (or similar) will be displayed. 
 
HICAPS 
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Bulk Bill from Billing 
 
HICAPS 

 
 
Tyro 

 
 
Tyro 
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Patient Transactions 
 
Go to the Transactions tab on the patient’s file. 
 

 
 
Click on the plus + symbol next to a billed item to see details of the Medicare claim. 
 

 
 
To submit an unclaimed item to Medicare, right-click on a billed item, select 
Medicare Easyclaim, then Patient Claims or Bulk Bill. 
 
Note: the Bulk Bill option is only available when no payment has been made.  
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Viewing Previous Transactions 
 
Select Medicare Easyclaim Claims from the System menu. 
 

 
 
The following window will be displayed. 
 

 
 

All Medicare Easyclaim claims processed in the last week will be displayed.  This list 

can be filtered by Claim Type (e.g. Bulk Bill, Fully Paid, etc), and Date Range. Click 

on the plus + symbol next to a claim for more details. 
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About MailChimp 
 
MailChimp is an online email marketing solution to manage contacts, send emails 

and track results. 

 

Front Desk’s MailChimp integration allows you to upload your client list to MailChimp, 

and keep it in sync with changes to Front Desk patient files. Front Desk also allows 

you to produce subgroups of this list (called segments) by using the standard Front 

Desk reports. The topics on this page should be used in conjunction 

with MailChimp’s documentation. 

 

The topics below assume you already have a MailChimp account, and some prior 

knowledge of MailChimp. 

 

 

Create a List in MailChimp 
 
Log in to your MailChimp account, select Lists, and click the Create List button.  

A new list must be created that will contain only your Front Desk client list. 

 

 
 

Enter the required details for your list, and click Save. 

 

 
Your MailChimp list is now ready for you to upload your client list. 
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Enable MailChimp Integration and Upload your Client List 
 
First you must get your API key from MailChimp. Go to your account details, select 
Extras, and API keys. 
 

 
 

If you don’t already have an API Key listed, click Create a Key. Otherwise, highlight 

and copy your API Key. 

 

 
 

In Front Desk, go to the MailChimp tab in System Information. Tick Enable 

MailChimp Integration and paste your MailChimp API Key. Then click Connect to 

MailChimp. 

 

a 
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Enable MailChimp Integration and Upload your Client List 
 
If successful, the following message will be displayed. 

 

 
 
The details of your account will be displayed to you, along with your MailChimp lists. 
If you have not yet created a list, please do so now. 
 
By default, archived patients will be excluded from the MailChimp sync, but if you 
want to include them, untick Exclude Archived Patients. Select your list, and click 
Upload. 
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Enable MailChimp Integration and Upload your Client List 
 
Click Yes to the confirmation message that will be displayed. 
 

 
 
If your client list is large, a progress window will be displayed, which can be cancelled 
at any time. If you decide to cancel, the sync can be resumed later. 
 
Once complete, the results of the sync will be displayed. This lists successful 
additions, along with any errors that have occurred. Click Close. 
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Enable MailChimp Integration and Upload your Client List 
 
Your list Members should have been updated to reflect your new list size. The Last 
Sync date will also have been updated. 
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Resolving Duplicate Email Addresses 
 
MailChimp doesn’t allow more than one subscriber with the same email address, so 
before each MailChimp sync Front Desk will check your clients for duplicate email 
addresses. For each duplicate email address you must select a primary contact.  
 
The primary contact will be the one whose details are included in the MailChimp 
sync. These are the details that will be included in any MailChimp campaigns, should 
you choose to personalise them by using list fields / merge tags. For example, if you 
have several members of a family in your client list, all of whom share an email 
address, one of those people will need to be selected before they will be synced to 
MailChimp. 
 
After clicking Upload or Sync, or before adding patients to a segment, you may see 
the following message. 

 

 
 
 
You will be presented with a list of any patients with duplicate email addresses. For 
each one you can choose to do nothing (in which case they will not be uploaded to 
MailChimp), or select a primary contact. 
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Resolving Duplicate Email Addresses 
 

 
 
If you need to change the primary contact for a patient you can do this using the 
MailChimp button, situated next to the Email field on patient files which have a 
duplicate email address. 
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Resolving Duplicate Email Addresses 
 
Note: patients who haven’t been chosen to be the primary contact for their email 
address can’t be unsubscribed from MailChimp. You must unsubscribe the primary 
contact. The MailChimp checkbox on these patients will be unavailable. 

 
 

 

Unsubscribing 
 
Patients can unsubscribe themselves from your MailChimp list by clicking the 
unsubscribe link in your email campaigns. Patients unsubscribed in this way cannot 
be subscribed again using Front Desk. 
 
You can choose to unsubscribe a patient by unticking the MailChimp checkbox on 
the patient’s file. The patient will be removed from your MailChimp list at the next 
sync. At any time you can resubscribe the patient by ticking the MailChimp checkbox 
again. 
 
Patients will be automatically unsubscribed from your list if they are deleted from 
Front Desk. They will also be unsubscribed if you archive them, and you have 
chosen to Exclude Archived Patients. 
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Segments 
 
A segment is a subgroup of your patient list. Segments can be used to target a 
campaign at a particular section of your patients. Front Desk can create segments 
easily using its standard reports. 

 
Segments can be created and managed by clicking the MailChimp button on the 
Recall Patient List, Active / Inactive Patients report, Birthday List, Patient 
Referrals report, Patient List, and Events Report. 

 

 
 
If your list contains no segments you will be prompted to enter a New Segment 
Name. 
 

 
 
The MailChimp Segments window will be displayed. This contains all of your 
segments. The number of selected patients is displayed at the top. 
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Segments 
 

 
 
You can choose to add the selected patients to one of your current segments, or to 
create a New Segment. Highlight the segment you wish to use, and click Add to 
Segment. You will be asked to confirm before Front Desk continues. 

 

 
 
When complete, Front Desk will display the following message. 
 

 
 
If any errors occurred, which could happen if trying to add a patient who has been 
unsubscribed from your list, Front Desk will display a summary of the failed email 
addresses. 
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Segments 
 
You can also use the MailChimp Segments window to create a New Segment, 
Reset (remove all of the patients from) a segment, or Delete a segment. 
 
When creating your campaign on the MailChimp website, you can choose to send to 
any of the segments created through Front Desk. 
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Creating a Physitrack account 
 

To use Physitrack integration you must create an account at www.physitrack.com. 
 
As a Front Desk user, a discount is also available on new Physitrack 
subscriptions. 
 
To apply the discount first create a Physitrack account, then when you reach the 
Payment Information screen:  
 

1) Select Front Desk from the ‘Affiliated with’ drop-down. 
 

2) Enter the code ‘FD40’. 
 

3) Click OK. 

 

 

 

http://www.physitrack.com/
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Enabling Physitrack for your practitioners 
 

Front Desk 2021 allows practitioners to integrate Physitrack exercise programs 
directly into their Clinical Notes.  
 
Follow the instructions below to setup the integration in Front Desk.  
 

1) Open the Practitioner window from File > Practitioners. 
 

 
 
2) Double-click the practitioner you wish to configure for Physitrack, then 

navigate to the Clinical Notes tab. 
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Enabling Physitrack for your practitioners 
 

3) Click the Physitrack integration option. 
 

 
 
This will prompt further instructions to follow on the Physitrack website. 
 

 
 
Please leave this window open until you have completed the steps 4-10 
below. 
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Configuring integration on the Physitrack website 
 

4) Open a web browser and navigate to the Physitrack website. 
 

 
 

5) Login to your account. 
 

 
 

6) At the bottom of the screen, click the My Account button. 
 

 
 

7) At the top of the screen, click the Settings tab. 
 

 
 
 
 

8) In the Integrations section select Front Desk from the drop-down list. 
 

 
 
 

9) Paste the API Key generated from the Front Desk Practitioner File, then 
click Save changes. 

 

 

https://www.physitrack.com.au/
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Configuring integration on the Physitrack website 
 

10) Return to Front Desk and the open Physitrack Setup window. 
 
Click the Check button. 
 
This will verify your successful integration with Physitrack for this practitioner.  

 

  
 
 
Congratulations, this practitioner is now configured for Physitrack 
integration. 
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Creating user logins for Physitrack integration 
 

As Physitrack integration is configured and used on a per-practitioner basis, it is 
important that each practitioner has their own Front Desk User Login. 
 
Additional user logins can be created by the ‘Admin’ user by following the steps 
below. 
 

1) Login to Front Desk as the Admin user. 
 

 
 

2) Go to the System menu and select Security. 
 

 
 

3) Click Add to create a new user, entering an appropriate Username and 
Password. 

 
4) For Physitrack integration, please ensure the User is a Practitioner option 

has been enabled and the login linked to the correct practitioner. 
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Using Physitrack with Front Desk 
 

With the user login configured you are now ready to begin using Physitrack 
integration.  
 
Please note Smartsoft cannot provide specific advice or assistance in the use of the 
Physitrack website or the creation of exercise programs and templates. 
 

1) Login to Front Desk as the appropriate user. 
 

 
 

2) Open a Patient File and navigate to the Clinical Notes tab. 
 

If the practitioner and user has been configured correctly a Physitrack button 
will be available in the bottom-right of the window. 
 

 
 

3) Click the Physitrack button, which will immediately open the Physitrack 

website and this patient’s file. If required a new Physitrack file will be created 

automatically for the patient. 

 

4) Click Assign new program to begin adding Exercises or Templates. 
 

 
 

5) With your exercises or templates selected, click the Edit Program button in 
the top right of the screen. 
 

 
 
This will then summarise the exercise program created.  
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Using Physitrack with Front Desk 

 
6) Click the Assign button to assign this program to the patient. 

 

 
 

7) The next window allows you to confirm the client details. 
 
Click Assign program. 
 

 
 

8) On the Client program settings window, click Close or Close Client to 

finalise the process. 

 

9) The assigned exercise program should then appear as a Clinical Note in the 
Front Desk patient file. This process may take a few minutes.  
 
For easy filtering these notes are automatically assigned with the Note Type 
and Condition/Region/Stage of ‘Physitrack’. 
 

 
 
The assigned exercise program is automatically attached to this note, which will 
display automatically on opening.  
 

 
 

Congratulations, you have successfully used Physitrack integration. 
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Setup Guide 

 
You will find full instructions below on how to setup both your existing Front Desk 
application and your iOS and Android devices to start using this feature. 
 
Checking your Front Desk compatibility  

You must be running Front Desk v19.0.4 or higher on your machines in order to 
communicate with the iOS / Android application.  

To check the version Front Desk you have installed, go to Help ► About Front 
Desk. 
 

 
 
If needed, Front Desk upgrades can be downloaded by logging into your account at: 
www.smartsoft.com.au/support  

Enabling the Global Messenger 

Open Front Desk and select the Messenger tab from within System Information. 

Select the Global option to be automatically assigned a channel. 
 

 

http://www.smartsoft.com.au/support
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Setup Guide 

 
You will receive a prompt to confirm that the new communication channel has been 
successfully authorised. 
 

 
 
Both Front Desk and the Front Desk Messenger will need to be restarted across all 
machines before this change will take effect. 
 
If needed the Messenger can be closed manually from the icon tray in Windows. 
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Adding Authorised iOS / Android Users  
 
From the Messenger tab of System Information, select the Authorised iOS / 
Android Users button. 
 

 
 
Click Add User to create a set of login details for each mobile app user. These 
details will be used to sign into the iOS / Android app.  
 
Important: 
 
The Display Name should be the same name as the Front Desk user login. This will 
allow you to receive your messages on your desktop and iOS / Android device at the 
same time. 
 
For this functionality to work each staff member is required to have their own Front 
Desk user name, which is also considered best practice for security and auditing 
purposes.  
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Installing the iOS / Android App 
 

 
iOS devices 
 
On your iPhone or iPad, open the App Store and search for Front Desk Messenger.  
 
Select Get to download and install. 
 
Android devices 
 
On your Android mobile or tablet, open the Google Play Store and search for Front 
Desk Messenger.  
 
Open the Front Desk Messenger within the store and click Install. 
 

 
iOS App Store     Google Play 
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Using the Front Desk Messenger on iOS / Android 
  

Open the Front Desk Messenger on your iOS / Android device. 
 
Using the credentials created in Step 3, you can now login to the mobile app. 
            

 
Success! You are now ready to use the Front Desk Messenger on your iOS / 
Android device. 
 
The mobile apps replicate the behaviour of the Front Desk Messenger for Windows.  
Simply select All Users or specific users on the left-hand side, then type a message 
to send. 
 
Additional information you need to know: 
 

• For any Front Desk Messenger client to be able to see an iOS / Android device for 

the first time, the device needs Front Desk Messenger open on-screen at the same 

time as the desktop application. This only needs to be completed on this first 

occasion. 

  

• Emoji support is not currently present in the desktop version of Front Desk 

Messenger. If you send an emoji, it will appear as random characters on a desktop 

computer. We are looking at addressing this at some stage in the future. Emoji are 

supported on the iOS / Android versions.  
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About WorkCover Queensland Invoicing 
 

WorkCover Queensland  
 
Through collaboration between Smartsoft and WorkCover Queensland, a business 
to business (B2B) online invoicing process has been developed for medical and 
allied health practitioners to bill WorkCover Queensland directly through Front Desk. 
 
Benefits in using this functionality include: 
 

• Secure transmission of invoicing information from your practice directly to 

WorkCover; 

• All sent invoices are available to be viewed through your WorkCover provider 

online account in the Send/History information; 

• You can use your WorkCover provider online account to track what stage 

your invoice is at with up to the minute information on the progress through 

WorkCover’s claim system; 

• Quicker turnaround times for processing as your B2B invoice is prioritised and 

invoice data no longer has to be entered manually by WorkCover. 

• Daily disbursements are available so that once the invoice is approved your 

payment will be disbursed each night. 

 

A WorkCover account is required to use this feature. To request an account please 
send an email with your practice details to providers.providers@workcoverqld.com.au 

(include reference to ‘B2B’ in the subject line) to obtain a B2B username/password 
which you can then add into Front Desk 2021. 
 

mailto:providers.providers@workcoverqld.com.au
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Configuration 
 

WorkCover Queensland electronic invoicing can be enabled on the Health Fund / 
EFTPOS / Medicare tab on the Advanced tab in System Information. 
 
You will only need to check the WorkCover Queensland Invoicing tick box. Leave 
any existing settings unchanged.  
 

 
 
After making this change, you will be asked to restart Front Desk 2021. 
 

 
 
After a restart, there will be a new WorkCover Queensland tab in System 
Information. 
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Configuration 
 

 
 
On this page you can enter your User Name, Password, Account Name, and Account 
Number, all of which will be provided to you by WorkCover Queensland upon 
request. 
 
This initial setup process will need to be replicated on all machines running Front 
Desk 2021 that are required to send WorkCover Queensland invoices. 
 

Practice Groups with a custom Australian Business Number 
 
Further, if the respective practitioner is a part of a practice group that has a custom 
ABN listed, the WorkCover Queensland Account Name and Account Number will 
need to be replicated on the WorkCover Queensland tab of the practice group as 
below: 
 

 



PAGE  228                                                                             FRONT DESK 2021 - PRACTICE MANAGEMENT SYSTEM 

WORKCOVER QUEENSLAND INVOICING 

 
Transmitting Invoices to WorkCover Queensland 
 

Invoices are generated and transmitted to WorkCover Queensland via the patient’s 
Transactions tab. Click Invoices to display the Invoices window. 
 

 
 
Select your Invoice Type, and click the WorkCover QLD button. 
 

 
 
If successful, you will see the following message. 
 

 
 
If the invoice submission fails, an error message will be displayed to the user. 
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Viewing WorkCover Queensland Invoices 
 

To view details of past invoices, select WorkCover Queensland Invoices from the 
System menu. 
 

 
 
From this window you can view a history of submitted invoices. Clicking the + symbol 
next to an invoice allows the user to see invoice details.  
 
By default, only successful invoices are shown. Drop down the Invoice Status option 
to view All invoices, or only Failed invoices. 
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Background 
 

Xero integration allows users to upload Front Desk transactional data to one or more 

Xero organisations, with three types of integration available: Daily Summary, 

Detailed and Detailed – Single Contact. 

 

Before using this integration, please note that Xero does not provide any 

means to reverse an upload made to their system. It is essential that you test 

your integration using a Xero trial before uploading data to your live 

(production) Xero organisation. Xero can provide users with a free 30-day trial 

organisation, which is ideal for this purpose.  

 

Though Smartsoft has provided deep integration with Xero, handling multiple 

businesses to one or more Xero organisations, including payment breakdowns 

suitable for real-world reconciliation, there may be situations that require manual 

adjustments in Xero.  

 

Although we consider the Xero integration to be an industry-best implementation, we 

provide the integration 'as-is' and users need to assess for themselves whether the 

integration is suitable for their professional use. Smartsoft does offer paid consulting 

services for assisted Xero implementation; however, we expect most users will be 

able to manage their integration and incur no additional costs.  

 

The first steps will be to create a free trial Xero organisation, generate your Xero 

integration keys, and configure Xero to allow integration with Front Desk. If you are 

new to Xero, it is essential to work with your accountant or bookkeeper to configure 

your Xero accounts in a way that suits your accounting and taxation needs. These 

accounts will then be set in Front Desk to determine where invoices and payments 

are uploaded within Xero. 

 

Importantly, you will need to decide on your integration mode, which cannot be easily 

changed in the future. If your accounting for taxation purposes is on a ‘cash-basis’, 

the Daily Summary mode is recommended. If your accounting is based on an 

‘accrual’ method, the Detailed or Detailed - Single Contact modes of integration 

can be used with the Detailed - Single Contact generally recommended. More 

information about the integration types can be found in this document.    

 

Please note that once an upload from Front Desk to Xero is performed for a date 

range, you cannot re-sync that period. It is therefore essential that only finalised 

accounting periods are synced from Front Desk to Xero. Typically, this would be 

periods from one or more months prior. 

 

Please familiarise yourself with this guide and the Frequently Asked Questions 

before proceeding. 

https://www.smartsoft.com.au/xeroconsult
https://www.smartsoft.com.au/xeroconsult
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Important Information  
 

 

 

 

Important:  
 
This guide has been written for the Xero integration of the Front Desk – Practice 

Management System. 

 

To integrate with Xero, you will need: 
 

• Front Desk v19.0.0 or above.  
 

• The following files, generated from the Smartsoft website (described in Step 3 
of this document): 
ss_certificate.cer 
ss_privatekey.pfx 
 

• Your private key password, also generated from the Smartsoft website. 

 

• Your Xero account information. 

 

We strongly recommend all users begin with a free trial of Xero, which can be used to verify 
your setup is correct before uploading on a live account.  
 
Smartsoft Pty Ltd is not responsible for any unwanted changes to your Xero account. 
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Step 1 - Create a trial Xero organisation 
 

Please begin by creating a free trial organisation in Xero, which can be used to verify 
your setup. Xero does not allow data to be moved, edited or deleted in bulk if 
mistakes are made. 
 

1) Navigate to https://www.xero.com/signup 

 

 
 

2) Enter your details and click Get Started. 

 
3) Follow the Xero sign-up process to verify your email, create a password 

and activate your account. 

 
4) Enter your Organization details, then click Start Trial. 

 
On completion, you will be directed to your Xero dashboard. Your 
organisation name should be displayed in the top left of the screen. 
 

 
 

Once you have confirmed your Xero setup using a trial organisation, you can then 

link to your live account and replicate the setup.   

 

https://www.xero.com/signup
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Step 2 - Creating Xero Accounts 
 

Accounts are an important part of the Xero system and fundamental to the 
integration with Front Desk.  When syncing to Xero, we need to know where Front 
Desk should upload Invoices, Payments Prepayments and Write-Offs. 
 
Users can upload to the default accounts in Xero OR create their own custom 
accounts. 
 

 
 
A basic setup will have an account for Invoices, Payments, Prepayments and 
Write-Offs.  
 
Alternatively, users can map an account to each payment method: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
or assign specific item codes to Xero accounts: 
 

 
 
Please refer to your accountant or bookkeeper to determine which Xero configuration 

best meets your needs.  
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Step 2 - Creating Xero Accounts 
 

Adding Accounts: 

 

1) From the Xero menu, click Accounting and select Chart of accounts. 

 
 

The Chart of accounts is used by Xero to categorise transactions, such as those we 
will be uploading from Front Desk. 
 

2) Click the Add Account button. 

 
 

3) Enter details appropriate to the account, then click Save. 
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Step 2 - Creating Xero Accounts 
 

 
 

4) Repeat as needed to create additional accounts. 

 

Adding a Bank Account: 

 

A bank account must be added in Xero to upload Unallocated Credits (Prepayments). 

We recommend the use of bank accounts for all Payment uploads, as this allows Xero 

reconciliation features to be used.  

 

1) Click the Add Bank Account button. 
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XERO INTEGRATION 

 
Step 2 - Creating Xero Accounts 
 

2) Select your Bank. 

 

 
 

3) Enter your Account Details, ensuring that you enter an Account Code. 

 
False details can be entered, if you do not want to link your actual bank account, but 
this may prevent you from using certain Xero features. 

 
4) Click Continue to add your bank account. 
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Step 3 - Generating Xero Integration Keys 
 

Before Front Desk can synchronise with Xero your account needs to be configured 
for integration. This requires Xero security ‘keys’ which can be generated and 
downloaded from our website: 
 

1) Navigate to https://smartsoft.com.au/support/upgrades  

 

2) Log in using your Smartsoft website credentials. 

 

3) Go to the Integrations tab and click Generate. 

 

4) This will generate a Public Key and Private Key for you to download.   

 
Download these files to your Front Desk 2000 directory. 

C:\Program Files (x86)\Front Desk 2000 or C:\Program Files\Front 
Desk 2000 
 

 
 

5) The Password should also be copied or downloaded, and will be required in 

Step 4. 

https://smartsoft.com.au/support/upgrades
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Step 4 - Configuring Xero to allow integration 
 

This involves registering Front Desk as an ‘App’ on your Xero account and uploading 
the appropriate security certificates. 
 

1) Navigate to https://developer.xero.com/myapps/. 

 
 
2) Click New App. 

 

3) Select Private app and enter an App name. 

 

4) Select the Organisation created for Xero in your initial sign-up. 

 

We recommend users begin with a trial organisation, before uploading any 

data into their live Xero organisation.  

 
5) In the Public Key area, leave the selection on Upload Certificate File, then  

drag-and-drop the ss_publickey.cer file you downloaded into the designated 

area. 
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Step 4 - Configuring Xero to allow integration 
 

 
6) Select Enable Payroll API for this organisation and then click Create App. 

 

 
7) The following window will display a summary of your authorised ‘App’ and 

include your Consumer Key. 

 
 

8) Click the Copy button to the right of Consumer Key.  

 

This will be entered into Front Desk in the following steps. If you lose this key 

beforehand, please return to https://developer.xero.com/myapps/ to copy the 

consumer key again. 

 

https://developer.xero.com/myapps/


PAGE  240                                                                             FRONT DESK 2021 - PRACTICE MANAGEMENT SYSTEM 

XERO INTEGRATION 

 
Step 5 - Enabling Xero integration in Front Desk 
 

1) Open Front Desk and login as the Admin user. 

 

2) Open System Information  and navigate to the Xero tab. 

 
3) Click Enable Xero Integration. 

 

 
 

4) Click Browse  to select your Certificate Location. 

 

Select the ss_privatekey.pfx file you downloaded from the Smartsoft 
website, which should now be in your Front Desk install directory.  
 

 
 

5) Enter the Certificate Password copied in Step 3. 

 
 

6) Enter the Consumer Key, as previously copied from the Xero Developer 

Portal. 

Refer to Step 7 of the previous section – ‘Configuring Xero to allow 

integration’. 

 

 

 
7) Click the Connect button to link Front Desk to your Xero organisation.  

 

https://developer.xero.com/myapps/
https://developer.xero.com/myapps/
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Step 6 - Selecting an integration type 
 

It is important that users select the appropriate integration type for their intended 
Xero usage. The integration type cannot be changed after syncing, and once data 
has been uploaded to a Xero organisation, it cannot be reversed. 
Front Desk has three types of integration with Xero – Detailed, Detailed - Single 
Contact and Daily Summary. 
 

 
 
Type 1: Detailed 

This mode of integration will upload each Front Desk patient as a separate Contact 
in Xero, with all outstanding and future invoices/payments syncing to each contact. 
 
Please note Xero recommends no more than 10,000 contacts per organisation. 

 

Pros Cons 

• Individual invoices and 
payments are available in Xero. 
 

 

• More contacts and invoices can 
be harder to manage in Xero. 

• Outstanding invoices can be 
tracked in Xero and forwarded 
to the individual contact. 

• Reconciling in Xero can be 
difficult, as payments are 
uploaded individually per patient. 

• Uploads the most information 
between Front Desk and Xero. 
 

• Suitable for accounting based 
on accrual. 
 
 

• Not suitable for practices with 
higher numbers of patients. 
 

• Not suitable for accounting on a 
cash-basis.  

 
Type 2: Detailed - Single Contact (Recommended for accrual accounting users) 

This mode of integration will upload all Front Desk transactions to a single ‘Front 

Desk PMS’ contact in Xero, with all outstanding and future invoices/payments 

syncing to the one contact.  

Each transaction will be uploaded with information to identify the patient it belongs to. 
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Step 6 - Selecting an integration type 
 
Pros Cons 

 

• Individual invoices and 
payments are available in Xero. 

 

• Invoices cannot be forwarded  
to clients via Xero. 
 

• All invoices are associated with 
a single contact, for easier 
management. 
 

• Suitable for accounting based 
on accrual. 
 

• Reconciling in Xero can be 
difficult, as payments are 
uploaded individually per patient. 
 

• Not suitable for accounting on a 
cash-basis. 

 

Type 3: Daily Summary (Highly recommended for most users) 

This mode of integration will only upload a summary of payments received. It does 

not upload individual invoices and payment transactions but instead syncs the totals 

of each payment method for the day. 

E.g. Your received payment totals in Front Desk for Thursday 10-01-2021 are: 

EFTPOS: $850.00  CASH: $200.00  CARD: $500.00 

  

An invoice and payment will be raised in Xero for 10/01/19 for each payment type: 

EFTPOS:   CASH:    CREDIT CARD: 

Invoice: $850.00  Invoice: $200.00  Invoice: $500.00 

Paid: $850.00   Paid: $200.00   Paid: $500.00 

 

Pros Cons 

• Designed for balancing and 
reconciliation in Xero. 

• Individual invoice and payment 
information is not uploaded to Xero. 
 

• Invoices and payments are 
totalled per day per payment 
method. 
 

• Includes smart payment grouping 
for easy matching against bank 
statements. 
 

• Suitable for accounting on a 
cash-basis. 
 

• Write-offs and credits are not 
uploaded to Xero. 
 
 

• Individual contact information is not 
uploaded to Xero. 
 

• Not suitable for accounting on a 
cash-basis. 

 

Cheque, direct deposit and Medicare/DVA payments are uploaded as individual 

payments for improved bank reconciliation in Xero. Payments made via HICAPS, 

Tyro or ANZ HealthPay integration will upload based on the health fund consolidation 

settings. 
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Step 7 - Linking Front Desk to Xero accounts 
 

1) In the Setup Xero Accounts area, select the account you wish to use when 

syncing Invoices, Payments, Prepayments and Write-Offs. 

 
 
Linking Payments to a Bank Account is recommended if you wish to use 
Xero reconciliation features. 

2) To nominate a Xero account for each Payment Method, click Advanced .  

If using the Daily Summary mode of integration, click Payment Methods. 
 
 

 
 
Individual Item Codes can also be configured with a Xero account. 
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Step 8 - Syncing practice groups to Xero 
 

If required, Xero organisations can also be configured per Practice Group. In this 
case, one or more Practice Group(s) will be associated with a Xero organisation, with 
the potential to sync to different Xero organisations from one Front Desk database 
instance. 
 

1) Open System Information  and navigate to the Groups tab. 

 

2) Select the practice group being configured for Xero and click Edit. 

 
 
3) Open the Xero tab. 

 
 

From here, users can: 
 

Exclude practice group from Xero integration. 
This will prevent invoices associated with this practice group from being uploaded to 
Xero. 
 
Connect practice group to a different organisation. 

This allows users to connect this practice group to a different Xero organisation. All 

invoices associated with this practice group will upload to the connected 

organisation. 
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Step 9 - Xero integration with multiple locations 
 

If your business operates from multiple physical locations, please ensure you have 
enabled and configured Multiple Locations in Front Desk. This tracks the physical 
location where payments have been made, and may be required to reconcile 
payments in both Front Desk and Xero.  
 

1) Login to Front Desk as the ‘Admin’ user.  

 

2) Open System Information and navigate to the Advanced tab. 

 

3) Enable Multiple Locations. 

 
4) Close and Save, then restart Front Desk. 

 

5) Re-open System Information and navigate to the Practice Locations tab. 

 

6) Click Add to create your physical locations. 

 

 
 

7) Set the physical location of each machine under Your Location. 

 

 

 
You are now ready to perform your first sync with Xero. 
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Step 10 - Syncing Front Desk with Xero 
 

1) Open Front Desk and login as the ‘Admin’ user. 

 

2) Open System Information  and navigate to the Xero tab. 

 
3) Click Sync.  

 

 
 
Each time you sync to Xero this Xero Sync window will appear.  
 

4) Select the Start Date and End Date you wish to start syncing all invoices 

from. 

Front Desk will upload all invoices to Xero between the selected dates, both 

paid and outstanding. 

 
5) Select whether to Include outstanding invoices prior to the start date. 

With this option enabled, Front Desk will also include outstanding invoices 

from before the start date.  

 

6) Click OK. 

 
Users can return to the Xero tab of System Information to sync again in the future.  
Future syncs will automatically update any existing invoices on your Xero account to 
reflect their changes in Front Desk (edits, deletions, payments, write-offs). 
 

Congratulations, you have successfully used Xero integration. 
 
Please note the integration between Front Desk and Xero is one-way; changes made 
manually in Xero will NOT be reflected in Front Desk.   
 
Smartsoft cannot provide specific advice or assistance in general accounting or the 
use of the Xero, including general troubleshooting, payment reconciliation and 
reporting. 
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Frequently Asked Questions 

 

I’m not familiar with Xero, how much support can Smartsoft provide?  

The Xero integration functionality has been provided on a self-install, self-manage 
basis. For users that would like an assisted integration setup, Smartsoft can provide 
professional services to assist with the configuration, setup and use of the Xero 
integration for the Front Desk product.  A link to these services can be found here.  
The creation and management of your Xero account, including all information 
uploaded from Front Desk, must be handled by the Front Desk user. 
 

Do I really need to start with a trial organisation in Xero? 

We strongly recommend beginning with a trial organisation in Xero. This will allow 
you to verify your account mapping between Front Desk and Xero, while also 
confirming the results match your expectations.  
If you upload to the wrong account or are not satisfied with the resulting information 
in Xero, please note it cannot simply be reversed or deleted. 
 
I am ready to sync to my trial organisation in Xero, where should I start? 

We recommend you start by syncing a period from several months ago, then verify 
the results. You should confirm: 

• Invoices and Payments are uploading to the correct accounts. 

 

• Your accounts are balancing as expected for the period. 

 

• If you are connecting to multiple Xero organisations via Practice Groups, 

confirm the split of invoices and payments is accurate. 

 

• The setup of Xero meets the needs of your accountant or bookkeeper. 

 
I’m ready to begin using a live Xero organisation, what should I do? 
Prepare your ‘live’ Xero organisation following Steps 1-3, then open a support case 
on our website for assistance: https://www.smartsoft.com.au/support 
 
Our support staff will help reset your Xero configuration in Front Desk so you can 
connect to a different organisation and complete Steps 4-10. 
 
When should I sync to Xero, and for what date range? 
We suggest users only sync closed or verified accounting periods, where no further 
changes will be made to your invoices.  
 
It should also be noted that invoices cannot be consolidated or unconsolidated after 

being uploaded to Xero. 

https://www.smartsoft.com.au/xeroconsult
https://www.smartsoft.com.au/support
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Frequently Asked Questions 

 
Why aren’t refunds uploaded to Xero? 
Front Desk and Xero have fundamental differences in how ‘refunds’ are recorded and 
managed. As this would create inconsistencies, all refunds will need to be added to 
Xero as a manual adjustment. 
 
Please refer to Xero support or your accountant for how these adjustments should be 
made. 
 
My Xero balance isn’t correct, what should I do? 

Depending on your Xero setup there are several reasons your balance might seem 
inaccurate. For example, if you’ve split payments across multiple practitioners, and 
those practitioners are uploading to different Xero organisations, the balance may not 
reflect as you are expecting. 
 
Another example is that you may bank an amount less than the income shown in 
Front Desk, due to your collected amount being short at the end of the day.  
 
Smartsoft can only provide limited support in identifying discrepancies and comparing 
reports or balances. You will first need to locate which invoice is causing the 
discrepancy before we can assist. 
 

Are there known limitations when integrating with Xero? 

Our integration to Xero is highly advanced, but there are still some known limitations.  
 

• After a write-off has been synced to Xero, it can only be removed by manually 

removing the credit note allocation in Xero and then voiding the credit note. 

 

• Once an unallocated credit has been uploaded to Xero it can only be 

removed by manually deleting the credit allocation in Xero. 

 

• Refunds are not uploaded to Xero. 

Xero does not allow certain actions via integration, which is why they need to be 
completed manually. 
 
I’ve made changes to a previously synced accounting period, what should I 

do? 

In the Detailed and Detailed - Single Contact modes of integration, we are actively 
searching for changes to previously uploaded invoices with each sync. This means, if 
you edit an invoice in Front Desk and that invoice was previously uploaded to Xero, 
we will attempt to update that invoice in Xero to reflect your changes. This is also 
how we update outstanding invoices to include new payments.  If you have added a 
new invoice to a previously synced period, this will be uploaded to Xero the next time 
you sync. 
 
In Daily Summary mode, sync periods are final. Once a period has been uploaded 
to Xero it is locked and will not reflect any changes made in Front Desk.  
 
In either case, we highly recommend only syncing closed and verified accounting 
periods. 


